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Platform Basics 
What you need to start using the Parallax Platform on your 
Computer. 

he Parallax Solutions Platform, or PSP for short, is software that resides on 
your computer and connects directly to the TradeStation (version 9.5 update 
28 or version 10.0 update 58 ) trading & charting software from TradeStation 
Securities (www.tradestation.com).   TradeStation (TS) is designed to access 

financial data over the internet and then facilitate back testing, charting, analysis, and 
real-time trading directly between their software and the TradeStation Securities 
brokerage. TS offers a software discount if you trade through them.  The award-
winning TS interface allows 3rd party vendors such as Parallax to design and deploy 
additional feature sets such as our PSP that are not included with the basic installation 
of TS.     

PSP also includes additional databases and dynamic link libraries (DLL’s) 
which will reside on your computer and will be updated periodically by Parallax, or 
dynamically by our tools inside of TradeStation.  Figure 1 shows how PSP is organized 
on your computer.   

 

 

 

 

 

 

Figure 1 Parallax Solutions Platform file organization chart.  Arrows show a two-way communication between the TradeStation 
program and data residing on the hard disk in the C:\Pfr folder 
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There are three Platform components that work together.  First, the C:\Pfr 
folder is created for databases, neural net files, lists, documents, backup data, and other 
Parallax-related information.  Second, the software is located in the C:\Pfr\Software 
folder in five DLL’s named PSP_CSLibrary.dll, PSP_Interface.dll, Chaos.dll, Pturn.dll, 
Wizlook.dll, and Channel.dll. The install program copies them into the TS “Program” 
folder:   

 (or in TradeStation 10.0 > Program) 

The last component is our PSP.ELD file, also located in C:\Pfr\Software, which is 
imported into TS directly via the install program or manually using File->Import 
button in TradeStation: 

v9.5      v10.0 

                                

Figure 2 Inside TradeStation, use the File->Import path to bring in the Platform methods. 
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Follow all the prompts and once importing is complete, all of the PSP.ELD tools will 
then be available for your use.   

Of course the simplest way to get started with PSP is to take advantage of 
Parallax’s remote installation and maintenance service.  With your permission and the 
remote control program TeamViewer or GoToMyPC (or another remote control of 
your choice), you can invite Parallax to log on to your machine and do the complete 
install remotely.  We will make sure everything is configured and working before 
logging off.  Our service also guarantees that if you have a problem or need personal 
instruction using the tools, we will be able to guide you live on your machine.   
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Configuring TradeStation for PSP
TradeStation has preset default behavior which can be amended to be more 

user-friendly, and also more useful for our toolkit.  The following is a step by step list 
of how to configure your TradeStation for optimal use with PSP: 

1. Charting Preferences.   

v9.5 

    

v10.0 (right click on chart window to see) 
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Be sure to check the box to prompt for format when creating a new 
chart window and do not show empty trading periods for traditional 
chart types: 
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2. Space to the Right and Chart Centering 

v9.5 

 

v10.0 

 

We recommend that you check “Center Last Price” and set 10 spaces 
to the right so that our indicators such as Precision Turn and Smart 
Channel can plot projections: 
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3. Amount of Data to Load 

We recommend that you load all the daily, weekly, and monthly scale 
data that TradeStation provides in order to make best use of our cycle 
model and channel tools.  Setting “100 years back” will always ensure 
you have all the data available.  For intraday data, we recommend at 
least 2000 bars of data. 
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4. Workspace Preferences 

We recommend that you manually open the workspaces that most 
interest you each day.  This is a personal preference, but I find it 
bothersome to have workspaces automatically opened: 
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5. Changing Display Colors 

TradeStation allows the user to change the display colors to anything 
the user desires.  Platform tools make use of color to convey market 
information, so it is important to enhance visibility as much as 
possible.  Go to Format->Window to change colors: 

 

 

6. Hiding the Order Bar 

The TradeStation order entry toolbar is visible when the product first 
loads.  Unless you are trading actively, you may want to hide the 
toolbar.  Simply press the X in the upper left corner.  To bring it back 
go to View->Order Bar 
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7. Backing Up Your Work 

TradeStation now provides an automatic backup function and we highly 
recommend using it.  We backup everything except cached data (which 
can be easily downloaded) on a daily basis: 

 

When filling out this form, remember to uncheck “Data Cache” and 
then select a storage destination that is secure and is also being backed 
up.  I recommend scheduling daily backups in the middle of the night: 
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Finding Platform Tools
TradeStation tools fall into the following categories: 

Indicators Studies that plot the result of calculations either on top of price 
or in a subplot 

PaintBars Studies that plot the result of calculations by changing the color 
of the price bars 

ShowMe Studies that plot the result of calculations by plotting a large dot 
above or below the price bar 

Probability Maps Studies that result in a gradient filled background plot of some 
probability density function 

Functions Non-plotting subprograms that may be called by the routines 
listed above 

 

Parallax tools also follow these categories, and always start with “PFR_” prefix.  To 
find our tools, first create a chart using either the “Chart Analysis” icon, or by selecting  

File->New->Trading App Window->Chart Analysis from the menu.  Once you have 
a chart displayed, select Insert-> Indicator (v9.5) or Studies->Add Study (10.0) 

v9.5     v10.0 

    

Next you will see a list of Indicators that can be applied to your chart.  Scroll down to 
the Indicators with the PFR_ prefix and select PFR_SmartChannel and click Ok: 
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v9.5     v10.0 

  
 
You should now see channel trend lines plotted on your price chart.  Note that 
if they are not parallel, that you are using a logarithmic price scale instead of a 
linear one.  
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The following table is a list of all PSP tools: 

Platform Name Analysis 
TS 

Type 
Version 

Bars 
Needed 

Description 

PFR_PriceWizard Fundamental Indicator 5.0 4Yr Fundamental price estimation neural 
net 

PFR_PriceWizard 
Portfolio Fundamental Indicator 5.0 3Yr 

Plot the weighted value of a stock 
portfolio 

PFR_BetaPredictor Fundamental Indicator 1.0 10 
Predicts stock beta to S&P 500 and 
sector using fundamental neural net 

PFR_FundamentalRank Fundamental Indicator 2.0 52 
Ranks stocks from 1 to 100 based on 
fundamental neural net 

PFR_ShortRatio Fundamental Indicator 1.0 0 
Display the number of days to buy 
back all shorts at average volume 

PFR_ValueRank Fundamental-
Utilities 

Indicator 1.0 0 Ranks a stock on a value to growth 
scale using a fundamental neural net 

PFR_Forecasters Fund-Quant Blend Indicator 1.0 100 
Agent based model to forecast future 
price direction 

PFR_Confluence Quant-All  Indicator 1.2 335 
Computes and combines the 
predictive edge for 7 quant predictors 
on 4 time scales 

PFR_ExtremeHurst Quant-Feedback PaintBar 7.0 335 
Marks Extreme Positive & Negative 
Feedback 

PFR_ExtremeHurstExit Quant-Feedback Strategy 7.0 335 Exit trades when extensions occur 

PFR_HurstFur Quant-Feedback Indicator 2.0 211 Displays Hurst exponents at multiple 
scale and the Hurst average 

PFR_HBands Quant-Feedback Indicator 1.0 58 
Price bands corresponding to all Hurst 
Exponent states 

PFR_RSIz Quant-Feedback Indicator 2.0 30 Statistical significance of up/down bar 
counts 

PFR_PrecisionTurn Quant-Cycles PaintBar 8.0 10Yr 
Finds dominant cycles and projects 
them forward into the future 

PFR_MACycles Quant-Cycles Indicator 1.0 173 
Uses moving averages to calculate 
two dominant cycle periods   

PFR_PriceMemory Quant-Geometry Indicator 2.0 500 
Calculates support and resistance 
prices and notify when near 

PFR_SmartChannel Quant-Geometry Indicator 4.0 500 
Finds parallel channels and offset 
targets 

PFR_TechnicalRank Quant-Geometry Indicator 2.0 500 
Ranks price series behavior inside 
channels from 1 to 100 on 
performance likelihood 
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PFR_SmartGeometry Quant-Geometry Indicator 2.0 200 
Finds 7-pivot neural net geometric 
price patterns and enhanced 
traditional patterns 

PFR_PriceVolumeAlert Quant-Volume PaintBar 1.0 221 
Identifies volume hotspots that often 
preceded greater than average price 
change 

PFR_PriceVolumeCross Quant-Volume ShowMe 3.0 339 
Searches for bullish and bearish price-
volume crossover events 

PFR_VolumeTrend Quant-Volume PaintBar 4.0 300 
Tracks trends by requiring trend 
persistence & volume increase 

PFR_ZBands Utilities Indicator 1.0 

 

Upgrade to Bollinger Bands which 
corrects Gaussian fat tail problem 

PFR_%Change2Dates Utilities Indicator 1.0 1yr 
Percentage change between two 
dates/times 

PFR_BiasedNormalDist Utilities ProbMap 2.0 
 

Plots expected price pdf as a function 
of up probability 

PFR_CompressArray Utilities Indicator 1.0  
Compress bar data:  make two day 
bars from single ones, etc. 

PFR_DataOrder Utilities Indicator 1.0 
 

Checks that data is in the correct 
order High>Low, C/O within H/L 

PFR_DumpOHLCV Utilities Indicator 1.0 
 

Exports ASCII price data to file. This 
data can be read back in using 3rd 
Party data entry 

PFR_DumpOHLCV_Spread Utilities Indicator 1.0 

 

Exports ASCII price spread data to file.  
This data can be read back in using 
3rd Party data entry 

PFR_DumpTMI Utilities Indicator 1.0 

 

Exports ASCII file containing the Turn 
Measurement Index (TMI) which is a 
scale independent curvature measure. 

PFR_DumpWizard Utilities Indicator 1.0 

 

Exports ASCII file containing Wizard 
valuation data 

PFR_MaxBarsExpected Utilities Indicator 1.0 

 

Convenient tool to load up data to 
RadarScreen while online 

PFR_LagPlot Utilities PaintBar 1.0  
Over plots one or two price charts 
with a +/- lag 

PFR_RelativeStrength Utilities Indicator 1.0 
 

Relative strength between two data 
series using adaptive moving averages 

PFR_ScalableFunction Utilities Indicator 1.0 
 

Tool which allows over plotting of any 
indicator on top of price 

PFR_Quality Utilities Indicator 1.0 

 

Used to detect low visual liquidity 

PFR_SessionLength Utilities Indicator 1.0 
 

Displays list of bar intervals that fit 
evenly into the trading day 

PFR_Description Utilities Indicator 1.0 

 

Security description 
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PFR_Trident Utilities Indicator 6.0  

Shows optimal stop and target prices 
for a given predictor edge and 
duration 

PFR_HardToBorrow Utilities Indicator 1.0 

 

Shows HB in RadarScreen if stock is 
hard to borrow 

PFR_Volatility Utilities Indicator 1.0 

 

Shows annualized historical volatility 

PFR_VWAP Utilities Indicator 1.0 

 

Shows intraday Volume-weighted 
average price 

PFR_BidAskSpreadPct Utilities Indicator 1.0 

 

Shows %difference between bid and 
ask prices 

PFR_SectorSPDRName Utilities Indicator 2.0 
  

Returns the Sector SPDR associated 
with a US stock 

 

TradeStation Crash/Startup Guidelines 

TradeStation does crash or have an incomplete shutdown sometimes.  When 
this happens follow these steps to bring it back up: 
 

1. Run the “Kill TradeStation” batch file that is in C:\Pfr\Tools 
2. Restart TradeStation but stay offline.   
3. If you need to change an indicator or strategy, open the Development 

Environment first and make changes.   
4. Open all desired workspaces 
5. Go online 
6. Wait for all charts to load 
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Platform Security
Parallax maintains a number of security measures to protect our software. 

First, we tie our software directly to your TS Customer Number, which can be found 
under Help->About 

 

 

 

We also maintain what are called “time bombs” inside our link libraries, that stop the 
PSP tools from working after a given date (obtained from the TS data feed and system 
clock), just in case a computer is lost or stolen.  At the upper TS level, our most critical 
functions are protected by a password.  If you attempt to open them, the following 
message will appear: 
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Edge & Duration 
Measuring Profit Potential 

dge is a concept often associated with games of chance, such as you might 
find in a casino.  Casino owners understand it well, because all the games give 
them a small edge over their players.  All the casinos need is a large volume of 
players and they are certain to make a profit.  As an investor or trader, this 

concept is no less important.  If the investor has an edge greater than zero, then by 
continuing to invest or trade many times, he is just as likely to net profits.   

What is an “Edge”?  Simply put, it is the excess probability of winning a game 
of chance (also referred to in this document as “Excess %Winners”).  We all know that 
the flip of a coin has a 50% probability of coming up heads. For that case we call the 
outcome random and so the edge is zero.  If he were to place a dollar bet each time the 
coin was tossed, after many tosses, his expected gain would be zero dollars.  If instead 
he was playing a game where he had say a 5% edge above random, then after playing 
1000 times and betting a dollar each time, he would be expected to walk away with 
$100 in profit.  Given that edge, he would have won about 550 times and lost about 
450 times, for a difference of 100.  In math we call this effect the law of large numbers.  
In other words, the more times you wager with a given edge and constant bet, the 
closer you will realize that edge.  Playing many times with a similar risk and a positive 
edge is the way to make consistent profits in the markets. 

We need an entry signal exhibiting a significant and stable edge.  Figuring out 
what constitutes a significant signal is the hardest part, but once a candidate is found, 
we need to know how much edge it has.  In markets we have a couple of additional 
hurdles.  Edges decay over time.  For example, the moving average crossover that 
signaled an upward period with an edge of say 3%, is unlikely to have any effect many 
bars later.  The initial edge decays over time until it reaches an edge of zero.  We call 
this time interval “Duration”.  We need to measure edge AND duration to have a 
complete picture.   

The other hurdle is that markets are often biased during certain periods of 
time, and for reasons that may be unstable.  Sometimes just picking randomly gives you 

Chapter 

E 
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an edge that is non-zero.  We need to measure the random background edge and 
subtract that effect to measure if our signal gives us a “net” edge.       

Edge Formula: 

 

Here is an example of a signal that we recently analyzed for a client. The test 
generated about 650,000 signal occurrences.  To find the edge and duration due only to 
the signal, we had to subtract the random background edge.  The random background 
is found by picking dates & symbols at random from the same time period as the 
sample was drawn and finding the edge for that cohort. The results of tabulating 
45,000 random background events and 650,000 signals are shown here as a function of 
time since the signal.  The result shows that the signals do outperform the background. 

 
 
The edge we are trying to isolate is the net edge after removing the background.  The 
following picture shows the net edge and its decay over time: 
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If we assume a generic model for the edge and duration as shown below: 
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then the distribution of probable future prices might look something like this: 
 

 
 
Notice that the more probable central yellow region bulges upward for a time, before 
returning to the level it started at.  This means that the non-zero positive edge is 
making it highly probable that price will be found at higher levels than where it started.  
Again though, to realize this, the investor must repeat the long trade many times with 
the same edge & duration….AND…the commission cost of the investment needs to 
be insignificant relative to the gain achieved from the expected price movement. See 
Appendix 1 for detail edge & duration testing. 

Edge and duration testing in this manner can be used on all time scales and for any 
“predictor” used to drive a market entry decision.  I urge anyone reading this to apply 
the same simple analysis to their own predictor testing. To go the next step and design 
trade management strategies is only going to be beneficial if there is a positive edge 
with significant duration.  In addition, the point of maximum expected return is 
typically about a third of the full duration. 

In the following chapters we will identify particularly focused and unique predictors, 
describe what they predict, and list their edge and duration model parameters.  
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Fundamentals, Feedback, 
& Forecasting 
The Science Behind the Tools. 

inancial market price movements are most certainly complex, but 
despite significant challenges, the quest to forecast markets has attracted 
intellectuals and fortune seekers for many centuries.  Much of modern 
probability theory is due to this quest.  Over the last century, two 

distinct schools of thought have developed regarding stock price movement.  
The most prevalent is the Efficient Market Theory, whose adherents believe 
that stock prices instantly reflect all the known information about a company.  
They believe that because of this, price motion is essentially random about 
intrinsic value, which preempts any ability to forecast.  They point specifically 
to the strong similarity between the “Gaussian” random variable distribution, 
and the distribution of log price returns.   

The other school of thought belongs to the Technical Analysts.  They 
believe that significant inefficiencies exist because of investor biases or 
behavior, and that by making certain measurements of the past, one should be 
able to forecast the future course of prices.  They believe that the market has a 
price memory.  We call this the “Crowd Effect”   

With the relatively recent advent of computers and readily available 
stock price data, financial scientists (and even an occasional geophysicist) have 
been drawn to sorting out the forecasting problem.  Substantial progress has 
been made in the last 30 years, especially with regards to recasting the problem 
in scientific terms.  Technicians have seen their observational pseudoscience 
transformed by fields named “Chaos Theory”, “Behavioral Finance”, 
“Complexity Theory”, and “Econophysics”, where the scientific method is 
being applied to the problem.  Meanwhile, the Efficient Market Theory, in a 
manner reminiscent of physics at the turn of the 20th century, has seen the small 
problem of “fat tailed” return distributions become a major theoretical 
deficiency.  The work by Andrew Lo at MIT and Didier Sornette at UCLA, and 
others have been especially focused on this issue.      

Chapter 

F 
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Parallax Financial Research has been focused on sorting out the 
forecasting problem since 1990.  We have found that it is best to separate 
market dynamics into fundamentally-derived value and crowd effect.  

 
 
Valuation is best handled by making multi-factor models.  One example 

of this is Zillow’s house pricing model that simultaneously considers factors 
such as zip code, square footage, age, mortgage rates, etc.  To determine stock 
price, we simultaneously consider earnings, industry, book, sales, interest rates, 
inflation, and other factors.  See Price Wizard for a more complete factor list. 

 
The crowd effect is no less important than value.  Complexity theory is 

the science of multi-agent systems that share simple rules.  In our case, one of 
these rules is that our investment agents (crowd) tend to pursue price.  If price 
is rising, it attracts attention and more investors buy. This boosts price and 
attracts more attention. This is positive feedback. Positive feedback can carry 
price to extremes far from value, forming price bubbles or busts.  Negative 
feedback is also evident, and occurs when the supply and demand are in 
contention for a particular security. More feedback yields more predictability, 
and Chaos Theory, is the science of feedback systems.   

 
Our investor crowd also operates by a second rule.  They are attracted 

or repulsed from certain key price levels of their own making, again through 
feedback.  These two simple rules produce emergent geometric patterns, such 
as trend lines, as well as price fluctuations that resemble statistical mechanics. 

 
We determined that the crowd effects can be separated into four distinct 

observable categories: Stochastics Pursuit, Critical Phase Transition, 
Quasiperiodic Cycling, and Emergent Geometry.  Each of these categories 
implies certain specific measurement tools that Parallax has now created.   

Negative 
Feedback 

Positive 
Feedback 
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So what is feedback?  Well, first of all there are two types, positive and 
negative:   

         
We have all experienced feedback in our everyday life.  Place a microphone a 
bit too close to a speaker, and then make a small sound.  Positive feedback 
continues to amplify that sound into a terrible screech.  In the moment before 
positive feedback begins, the system is unstable, as illustrated by the ball sitting 
on top of the curved hill.  Instabilities like this precede many positive feedback 
phenomena such as earthquakes, avalanches, and strong financial price 
movements.  The end of a positive feedback event can be spectacular.  The 
avalanche runs out of unstable snow as it sweeps down the mountain.  An 
earthquake stops as all the accumulated stress is released.  Financial panics or 
manias end when nobody is left that has not bought or sold. 
 

 
 

 

 

 

 

Negative feedback examples are even more common and far less 
dramatic.  The thermostat in your house controls the temperature through 
negative feedback.  As the room temperature rises, the thermostat switches the 
furnace off, which in turn results in a lower room temperature, causing the 
thermostat to switch the furnace on again.     

Positive feedback: Process in which 
perturbation causes system to travel further 
away from initial state: 

Negative feedback: Process which causes 
a system to return to its initial state upon 
perturbation: 



T H E  S C I E N C E  B E H I N D  T H E  T O O L S  

 Parallax Client Communication 26

The investment experience incorporates both forms of feedback.  We associate 
value-oriented investing with negative feedback, in that an investor concerned with 
estimating a company’s stock value, is likely to buy when he believes the stock is 
undervalued, and sell when it is overvalued, much like the thermostat.  One could think 

of this as rational investing, in that the only dynamic driving prices should rationally be 
a concern about asset value.  Unfortunately there is another very strong motivator 
which dominates markets and can lead to undesirable consequences.  I am referring to 
momentum investing.   

Buying because price is rising, without regard to value, leads to a positive 
feedback environment.  Rising prices attract more buyers, which lead to higher prices, 

and more buyers, in a vicious cycle (another name for positive feedback).  Just 
remember that microphone screech the next time a market is booming or crashing, 
because positive feedback works both ways.   

   

Fundamental value 

Fundamental value 
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 Think for a moment about these two competing models for price action.  One 
can easily imagine the tendency to overshoot and undershoot true value.  If price is 
moving rationally from undervalued to overvalued, then that upward movement will 
attract those that are anxious to ride the wave higher.  As the value investor is about to 
sell, he might be coerced into modifying his behavior for the hopes of a bit more, while 
the trend followers are piling on.  The result is a sharp and convincing run to much 
higher prices than would normally be prudent.   

We tried making a simple model incorporating these two rules, just to see what 
this might look like, and sure enough, price swings did just that: 

 

In the figure above, intrinsic value is shown in red, while simulated price is shown in 
blue.  Price does follow intrinsic value in a broad sense, but some of the swings, 
specifically near 313 and 360 show large overshoots due to momentum investors. Our 
goal has been to build tools that can help map out the dynamics shown in this model.   

In the negative feedback realm, price is near equilibrium, and we are focused 
on intrinsic value estimation.  Our Price Wizard neural net estimates a fair fundamental 
price for about 2500 stocks each month.  We also have tools to estimate portfolio 
valuations, beta to the market and industry, value vs. growth rankings, and more.  Price 
support and resistance are also negative feedback phenomena, which we map through 
our Price Memory and SmartChannel products. 

 In the category of positive feedback, we have focused on mapping trends with 
VolumeTrend and SmartChannel products, and detecting the price swing extremes by 
borrowing tools from critical phase transition physics.  Our ExtremeHurst and 
Precision Turn tools are both oriented toward forecasting the beginning and end of 
price trends.   

overshoot 

undershoot 
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 “Fusion” is the term used for combining fundamental and quantitative 
methods together.  We use it to represent the combining of positive and negative 
feedback methods.  In a book called “Profiting by Chaos”, Tonis Vaga suggested using 
potential wells as a method of visualizing price states.  

 In the figure below, four states are shown.  The first two and last are unstable 
and away from equilibrium.  Just a slight nudge and the first ball “A” will run toward 
higher or lower prices very fast.  As discussed previously, this is a positive feedback 
state.  Our ExtremeHurst compression predictor will identify this point.  They occur 
just before a new trend kicks off, usually with a volatility breakout.  

Ball B is also unstable, but has high trend persistence.  Price at this point is 
moving very persistently in one direction.  Our VolumeTrend indicator combines 
price, volume, and the Hurst exponent to help the trader ride strong trends.  As the 
second ball reaches the end of its run at ball D, it will start climbing the other side of 
the well, slow down, and reverse. It will become what we call extended, and reverse 
back down into the well and swing back and forth wildly due to negative feedback.   

Our ExtremeHurst tool identifies extension events at D and compression 
events at A.   

Ball C represents the market at a stable equilibrium, with negative feedback 
price swings back and forth in a range.   The overall tilt of the two potential wells could 
be thought of as a fundamental bias, while crowd effects control the positive feedback 
periods.   
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The tendency of markets to organize themselves into unstable positions far 
from equilibrium is called “Self-Organized Criticality” or SOC for short.  We believe 
that markets regularly migrate from equilibrium, shown by ball C, to a high potential 
energy state shown by ball A, and then repeat the process described above: 

 

It is our belief that by combining our tools and this mental model of market 
dynamics, any professional manager will be able to improve performance.  That is our 
ultimate goal.   
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Negative Feedback Tools: 
Finding Price Equilibrium  
The Application of  Neural Networks to Estimate a 
Fundamental Stock Price  

egative feedback  can be thought of as the fundamental restoring force in 
financial markets.  It is negative feedback which attracts buyers to 
undervalued stocks and sellers to overvalued ones, in a never-ending search 
for intrinsic value.  Unusual as it might seem, this search goes on at all scales, 

even the dynamic intraday world, regardless of the presence of fundamental news.  
Price may be bid up to an old high from an hour ago, and appear to reverse course, 
falling back to a recent short term low.  Our work shows that these reversal points are 
anything but random.  Instead, the market has a memory for prices at which prior 
purchase decisions were made.  Prices are self-referential.  So the two types of tools 
included here attack these two manifestations of negative feedback:  1) the search for 
intrinsic, unemotional, fundamental price, based on existing facts, and 2) The memory 
of significant prior purchase and sale decisions.   

  

Chapter 

N 
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Price Wizard™
Fundamental analysis, primarily used to analyze stocks, is the study of financial 
data such as corporate earnings and financial statements as well as the 
economic factors that influence supply and demand to forecast price movement. 
Fundamental analysis enables you to study the causes of price movement, and 
can provide insight as to how the market's price should perform.  Price Wizard 
is a set of pre-trained sector neural networks through which current corporate 
fundamental data is processed each month to find the stock’s intrinsic price.  It 
does not produce a relative value, but an absolute price.  This has a number of 
advantages in screening stocks.   

PFR Paper:  The Application of Neural Networks to US Equity Pricing 
and Classification 

TS Name:  PFR_PriceWizard 

Version:  5.0 

TS Type:  Indicator 

Series:   US Equity 

Scale:   D | W | M    

Recommended Usage: 

Best used as a stock screening tool.  Stocks which are 
undervalued with price increasing and valuation increasing 
usually offer the best advantage.  

Maintenance:  An updated database is emailed once a month 

See Also: PFR_PriceWizard Portfolio 
Inputs: 

NAME DESCRIPTION DEFAULT 

HistoryEndDate 
Allows the user to set a specific date for the valuations – nice  
in RadarScreen if you want the valuation say 12 months ago 

Date 

DisplayText Toggles the text block on and off true            

DisplayCoReportLine 
Toggles a dashed line extending from the valuation back to 
the last fiscal quarter report for which we have data 

false                 

DumpData 
Enables the valuations to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 
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Chart Output: 

The maroon bars shown in the figure below were drawn by the indicator and represent 
what the program believed the stock MSFT was worth at the time drawn.  This pricing 
tool uses only fundamentals, and does not know about actual price or price changes.  
The text gives a detailed view of the current valuation in the stock, its sector, and 
industries, as well as the date of the last company report and database update. 

 

 

The text shown below is the enlarged version from the chart above.  The first line gives 
the current valuation and the percentage change required for real price to reach this 
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level.  In other words, MSFT needs to move down 15% before it will reach our 
valuation. 

 

Similarly, aggregate valuation information is given for the sector and industry.  Note 
that these valuation lines are color coded, where green is undervalued and red is 
overvalued.  In the case of MSFT, there are 439 information technology stocks, and 
51% of them are undervalued by some amount.  The average stock is undervalued by 
9%. 
 
RadarScreen Output: 

 
 
 
 
Performance: 
This is a picture of the average 12-month performance of stocks that were undervalued 
by at least ½ percent according to Price Wizard.  These undervalued stocks were then 
grouped by deciles and averaged over a 10-year period.  The returns are relative to the 
average performance of all stocks through the period.   
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Ford Equity Research uses a discounted cash flow method to estimate equity valuation.  
This figure shows that Price Wizard™ is quite comparable to their technique over the 
period studied. 
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Information Coefficient or IC is an accepted measure of skill for ranking stocks.  IC is 
calculated as follows:  1) Rank the stocks from best long ideas (forecasted highest 
return) to best short ideas (forecasted lowest return).  2) Rank the subsequent period 
actual returns, e.g. one month or 6 month from highest return to lowest return. 3) 
Calculate the correlation between those 2 series of numbers.  The higher the IC, the 
better is the skill.  A good IC is typically in the .05-.06 range, and above .07 is generally 
considered excellent. 
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Price Wizard Database and 
EXCEL™ Spreadsheets 
The results of our Price Wizard stock pricing model are sent to clients each month 
in two forms, as a binary database for use in TradeStation, as an EXCEL 
spreadsheet.  In addition we also include a summary spreadsheet report with 
aggregate valuation information.  The following picture shows the EXCEL database 
format for the August 2004 report: 

 
Table 5. EXCEL spreadsheet containing estimated prices for all stocks with sufficient 
data. 

The fields listed across the top include symbol, company name, sector name, industry 
name, market cap, month-end price from the prior month, estimated price (called 
“netprice”), and the percent change between the month-end price and our estimated 
price.  

Another EXCEL report contains statistics on various collections of stocks.  The 
August 2004 report is shown below.  At the top of this report is the statistical analysis 
of the stocks by common industry.  For instance, in the apparel industry, there are 37 
stocks, of which 16% are undervalued.  The average price is 18% over the actual 
market price, and the median price is 20% over the market price.  Not a very attractive 
industry.  The report looks at sectors, market cap ranges, value versus growth, and 
industry breakdowns.   
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Table 6. EXCEL spreadsheet containing valuation statistics by sector, industry, market cap, and 
value/growth rank. 

The next three pictures were created in EXCEL and derived from the October 2007 
summary report.  The first shows the median valuation by sector, the second by style 
group, and the third by market cap: 
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GICS sector and industry codes are given in the following table: 
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Fundamental Rank™
Our valuation tool Price Wizard takes a snapshot of current valuation, but does not 
incorporate any information about how quickly that valuation might be rising or falling.  
Likewise, no market price information has been included in Price Wizard.  Our 
Fundamental Rank neural net  incorporates the 1, 3, 6, and 12 month rates of change 
in valuation and actual price, with the current valuation, to give an overall attractiveness 
rank from 0 (unattractive) to 100 (attractive).     

PFR Paper:  The Application of Neural Networks to US Equity Pricing 
and Classification 

TS Name:  PFR_FundamentalRank 

Version:  2.0 

TS Type:  Indicator 

Series:   US Equity 

Scale:    D | W | M    

Recommended Usage: 

Best used as a stock screening tool.  Stocks which are ranked 
above 90 usually offer the best advantage.  

Maintenance:  An updated database is emailed once a month 

See Also: PFR_PriceWizard, PFR_WizardPortfolio 
Inputs: 

NAME DESCRIPTION DEFAULT 

LookUpDate 
Use a date other than today if desired.  Good for use in 
RadarScreen.  Date in YYYMMDD, so Feb 4, 2014 is 
1140204 

Date 

HistoryBars Number of bars back to plot historical signals 1 

BuyPercent 
Minimum threshold for a bullish signal.  Bearish threshold is 
set at 100-BuyPercent 

90 

DisplayText Toggles the text block on and off false            

DumpData 
Enables the ranks to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 

Chart Output: 

The colored numbers represent the Fundamental Rank, where green is bullish and red 
is bearish.  The colored dots show up when the trigger threshold, 90 for buys, and 10 
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for sells, is exceeded.  The model shorthand name is “F%(10)”, which stands for 
Fundamental Rank from Neural Net Model 10. 
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Performance: 
This is a picture of the average 12-month performance of stocks grouped by 
fundamental rank increments of 10% and averaged over a 13-year period.  The returns 
are relative to the average performance of all stocks through the period.  The best 
stocks with F%>90 exceed the random background by about 11% over a year, while 
the F%<10 stock group underperforms by 10% 

 
 

Name 
                 

Parameters Direction 
Excess 

%Winners 
Peak 

Duration 
Half-Life 
Duration  

Sample 
Size 

FundamentalRank 
>=90%, 

Model=10 Buy 6.47% 10 months 
>12 

months 58950 

FundamentalRank 
<=10%, 

Model=10 Sell 8.13% 12 months 
>12 

months 21510 

  



N E G A T I V E  F E E D B A C K  T O O L S  

 Parallax Client Communication 44

Portfolio Valuation Tools
Parallax has a tool called Wizard Portfolio to find the aggregate valuation of stock 
portfolios using Price Wizard as the basis.  It reads a file with a list of stocks and their 
respective weights.  It then scans our database for the valuation of these stocks, applies 
the given weights, then graphs the historical portfolio value.  This may be used for 
ETF valuation.  

PFR Paper:  The Application of Neural Networks to US Equity Pricing 
and Classification 

TS Name:  PFR_PriceWizard Portfolio 

Version:  5.0 

TS Type:  Indicator 

Series:   US Equity 

Scale:   D | W | M    

Recommended Usage: 

This tool is used to value a whole portfolio of US stocks.  It 
may be used for pricing ETFs as well.   

Maintenance:  An updated database is emailed once a month 

See Also: PFR_PriceWizard 
Inputs: 

NAME DESCRIPTION DEFAULT 

PortfolioFile Full pathname to list of stock symbols to process 
"defaultfile" will use the 
symbol and look for the 
file C:\Pfr\Lists\symbol.csv 

DumpData 
Enables the valuation to be written to an ASCII file 
in the C:\Pfr\Dump folder 

False 

 

Output: 

 
For each time slice, the weighted sum of all portfolio stocks is calculated using both 
market prices and Price Wizard prices.  The percentage difference is plotted relative to 
the symbol loaded in TradeStation data1.  For an ETF then, the portfolio of stocks for 
that ETF will produce the exact Price Wizard aggregate price.  If an unrelated index 
such as the S&P 500 is in data1, then the output can be interpreted as the relative 
valuation of the portfolio to the S&P 500.    

P F R  N A M E :  

WIZARD 
PORTFOLIO 
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The following is the top of an example portfolio file.  Note that the symbol name is 
followed by a comma and the portfolio weight associated with that symbol. 

 

Examples (SPY and SPDRS): 

 



N E G A T I V E  F E E D B A C K  T O O L S  

 Parallax Client Communication 46

 

 

In TradeStation RadarScreen the Wizard Portfolio routine can be used to display the 
current value of many portfolios at once: 
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Value Rank™
This tool analyzes company fundamental data and determines if the company is a value 
or growth company on a scale from 0=pure growth to 100= pure value.  Russell does 
something like this to decide which stocks to place in their value or growth indices.  
This tool simulates that same ranking process. It is not a predictor of future stock price 
movement, but is useful in stock screening.  

PFR Paper:  The Application of Neural Networks to US Equity Pricing 
and Classification 

TS Name:  PFR_ValueRank 

Version:  1.0 

TS Type:  Indicator 

Series:   US Equity 

Scale:   D | W | M    

Recommended Usage: 

Best used as a stock portfolio construction tool to separate 
value and growth stocks. 

Maintenance:  An updated database is emailed once a month 

Inputs: 

 

NAME DESCRIPTION DEFAULT 

DumpData 
Enables the value rank to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 

 

 Output: 

Outputs a number from 0 to 100 representing the degree to which the company 
matches a pure value or growth company.  0=pure growth and 100=pure value. 
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Example: 
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Beta Predictor™
This tool analyzes company fundamental data and determines what the beta to the 
S&P 500 and sector should be.  We have found that outperformance is likely if the 
natural log of actual beta divided by predicted beta falls between 0.6 and 1.0  Likewise, 
significant underperformance occurs if the natural log of the actual beta divided by the 
predicted falls between negative 0.6 and negative 1.0  

PFR Paper:  The Application of Neural Networks to US Equity Pricing 
and Classification 

TS Name:  PFR_BetaPredictor 

Version:  1.0 

TS Type:  Indicator 

Series:   US Equity 

Scale:   D | W | M    

Recommended Usage: 

Best used as a stock screening tool. 

Maintenance:  An updated database is emailed once a month 

Inputs: 

 

NAME DESCRIPTION DEFAULT 

PlotPredictedBeta Plot the predicted beta to the S&P 500 True 

PlotSectorBeta Plot the predicted beta to the sector True 

PlotActualBeta Plot actual measured beta to the S&P 500 True 

DumpData 
Enables the betas to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 

LockDate Calculate beta only through a given historical date yyymmdd 0 (today) 
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 Output: 

Three plots are generated by this indicator, Actual Beta to the S&P 500, Predicted 3Yr 
Beta to the S&P 500, and Predicted Beta to a representative sector index.  A filter turns 
the plots green if the conditions are good for outperformance, and red for 
underperformance, as determined by our testing. 

Example CSCO: 

 

In RadarScreen: 

 

Performance: 

Name Parameters Direction 
Excess 

%Winners 
Peak 

Duration 
Half-Life 
Duration  

Sample 
Size 

BetaPredictor 0.6<=Ln(B/pB)<=1 Buy 4.13% 
12 

months 
>12 

months 13674 

BetaPredictor 
-1<=Ln(B/pB)<=-

0.6 Sell 2.78% 
12 

months 
>12 

months 9736 
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Price Memory™
The concept of support and resistance is as old as markets, yet if their existence is 
statistically significant, it implies that a feedback loop exists between price movement 
and investor decisions.  If prior price levels do influence investment decisions, then 
markets can be said to have a collective price memory, which makes them somewhat 
predictable.  Parallax has designed a tool to identify and plot the most likely prices at 
which to expect this behavior.  We have found that if price stops just shy of support or 
resistance (0.5 standard deviations for a 1 bar move with historical volatility), then for 
the next few bars, price has a significantly higher probability of NOT crossing over the 
line on a closing basis.   

PFR Paper:  NA 

TS Name:  PFR_PriceMemory 

TS Type:  Indicator 

Series:   All market series 

Scale:   All scales except tick  

Recommended Usage: 

Best used as a short term 1-4 bar trading tool. Fade the 
support or resistance when the alert signals. 

Maintenance:  None 

Inputs: 

 

NAME DESCRIPTION DEFAULT 

History_Bars Number of bars back to plot historical signals 200 

DumpData 
Enables results to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 

 

 Output: 

Dotted price lines are drawn above and below price to represent support and 
resistance.  If price closes below support (down trend) then the subsequent color 
scheme is red and dark red, while if price breaks upwards and closes above resistance, 
then the color scheme switches to green and dark green (up trend).   

If price closes within 0.5 standard deviations from the boundary, an alert is generated 
and the color of the support/resistance line changes to indicate a trading opportunity.  
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A trading edge is achievable if the next bar opens within the boundary, and an entry 
can be made directly on the boundary 

Example GM: 

 

 

Case A: possible to sell on resistance 

Case B: not quite possible to sell on resistance 

Case C: possible to buy support, but it then breaks 

 

Performance:  When a boundary entry appears possible: 

Name Parameters Direction 

Excess 
%Winner

s 
Peak 

Duration 
Half-Life 
Duration  

Sample 
Size 

PriceMemory 
 
 

Uptrend Resist 
z<=0.5, open 

below, then limit 
short Buy 13.80% 1 day 3 days 

26839 
days 

PriceMemory 
 
 

Uptrend Support 
z<=0.5, open 

above, then limit 
buy Sell 15.31% 1 day 4 days 

24312 
days 

PriceMemory 
 
 

Downtrend Resist 
z<=0.5, open 

below, then limit 
short Buy 11.83% 1 day 4 days 

26601 
days 

PriceMemory 
 
 

Downtrend 
Support z<=0.5, 

open above, then 
limit buy Sell 15.01% 1 day 4 days 

26610 
days 
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SmartChannel™
Many feedback systems exhibit fractal geometries. We have all seen the intricate fractal 
patterns in nature.  They are all around us in flowers, snowflakes, trees, and also less 
visibly in the stock market.  All of these systems produce geometry through a feedback 
process.  In pure cases, each step of growth depends in some way on the last. The 
resulting fractal geometric structure is said to be “self-similar”, meaning that a 
fundamental pattern is repeated within a larger scale version of itself, which in turn is 
nested within another larger scale copy, and so on.  

So just what constitutes the presence of “price geometry” in the financial markets?  In 
the market, which is far from a perfect natural system, the pattern within pattern 
geometry was first discovered by R.N. Elliott long before chaos theory, and is most 
easily seen by looking for nested parallel price channels. 

Technicians have long observed the curious tendency of almost perfectly parallel price 
channels to form, often with numerous contact points.  These channels are recognized 
by their geometry, and tend to nest inside of bigger scale channels. 

The reasons for finding and using these channels are that it gives us a point of 
reference for judging the probability of future price movements, allows us some 
measure of trend, and confirms the presence of an active investor interest.  We can 
make judgments about the levels to set targets and stops.  We can also estimate the 
price levels reached if the channel continues unbroken for a period of time. There is 
also no built-in lag or drop-off effect.  If today’s bar breaks the channel, it’s broken.  
We don’t have to wait a few days for moving averages to cross over.  Once a channel is 
found, it just extends into the future.  There are never any days dropped off the back.   

The Parallax channel finding tools use a high-speed geometrical algorithm to search for 
parallel channels.  The candidates are screened for contacts, compactness, and the 
degree to which they are parallel.  A complete analysis of each channel is done which 
covers volatility, trend, and volume accumulation.  These are fed into a neural net to 
give a further overall forecast.   

Channels may also be used for geometrical price projections.  Price breaking a channel 
usually leads to a run at a price target which is one channel width away on whichever 
side the break occurred.  Our channel forecast tool finds past channels that have been 
broken, where there is an offset target that has not yet been hit.
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PFR Paper:  NA 

TS Name:  PFR_SmartChannel 

TS Type:  Indicator 

Series:   All market series 

Scale:   All Scales   

Recommended Usage: 

Channels are best used to map trends and changes in trend.  
Channel breaks are usually an early warning sign of a new 
trend. Channel projection lines may often be used for profit 
take points.  Channel color is a strong bullish/bearish price 
predictor 

Maintenance:  No maintenance is required 

See Also: PFR_TechnicalRank 
Inputs: 

NAME DESCRIPTION DEFAULT 

StartBar The number of bars back to calculate channels.  So on a 
daily chart, a startbar of 10 would cause a display of the 
channel structure as it existed 10 days ago 

0  

MaxChannels Maximum number of channels to draw from 1 to 40 5 

LogPeriodicWavelength The wavelength most cited for log-periodic cycles is 2, 
which corresponds to period doubling.  To find Fibonacci 
cycles use 1.618 

2.00 

PlotLogPeriodicCycles Display convergent log-periodic projection lines when price 
breaks out of a channel 

false 

PlotLogPeriodicTarget Display the final log-periodic target projection lines when 
price breaks out of a channel 

true 

ProbMax Set the probability limit for finding a random parallel 
channel.  P< 1 in 1,000 is suggested 

0.001 

ExtendLeft This allows the channel lines to be extended to the left into 
the past 

false 

ExtendRight This allows the channel lines to be extended to the right into 
the future 

true 

ShowExpiredChannels Show channels that are far in the past (expired) false 

Max_BarsBack Min number of bars back required for calculations 500 
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Dump_Data Writes Channel data to an ASCII file called 
SmartChannel.csv in folder C:\Pfr\Dump 

false 

Output: 
Channel output uses text, line thickness, and color to communicate important 
information: 

The channel line thickness varies by the number of contacts made. The more price 
points that touch a line, the thicker the line is drawn. 

 
 
 
Channels are colored by the neural network predictor (see Technical Rank) output on a 
scale from 0 (bearish) to 100 (bullish), using either color spectrum shown below: 

 

 
 

Each channel is found by scanning historical price data.  The date on which each 
channel was found is also marked on the screen by either a carat “^” or a star “*”, 
along the channel bottom on the channel date.  The star indicates that the user 
selected to lock in the channel on that date, while the carat indicates the algorithm 
found the channel without constraints. 

 or   
 

C H A N N E L  

T H I C K N E S S   

C H A N N E L  

C O L O R    

C H A N N E L  

L O C K  
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The channel forecasting tool attempts to find a significant historical channel that has 
recently been broken.  These channels are colored Gray.  When a channel is 
breached, the price will often run to a price that is offset from the break point by 
exactly the amount of the prior channel width.  This effect is linked to log-periodic 
cycling with a wavelength of 2.  The chart below shows the offset projection line 
that was forecast at the time the channel broke.  As you can see, price did run to that 
target line and is now oscillating about it: 
 
Examples:  

 

 

 
  

C H A N N E L  

O F F S E T  

T A R G E T S  
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Signals: 

          
 
 
In RadarScreen: 
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Performance: 

 
 
See also “Technical Rank” for the performance of channel alerts 
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Technical Rank™
This tool analyzes data from trend persistent periods, as designated by SmartChannel 
parallel channels.  A neural net has been trained on such factors as volatility, volume 
accumulation, trend persistence, trend line contacts, price position within the channel, 
and power law price action, in order to predict future price action.  The duration of 
forecast is approximately 20% of the channel length forward.  A low number is bearish 
and a high number bullish.   

PFR Paper:  NA 

TS Name:  PFR_TechnicalRank 

Version:  2.0 

TS Type:  Indicator 

Series:   All market series 

Scale:   All scales except tick    

Recommended Usage: 

Best used as a scalable market direction predictor 

See Also: PFR_SmartChannel 
Maintenance:  None 

Inputs: 

 

NAME DESCRIPTION DEFAULT 

HistoryBars 
Number of bars back to plot historical signals (signals are 
time consuming) 

1 

StartBarOffset Number of bars in the past to start looking for channels 0 

BuyPercent 
Minimum threshold for a bullish signal.  Bearish threshold is 
set at 100-BuyPercent 

90 

DisplayText 
Displays the numeric rank color coded from bearish=red=0 to 
bullish=green=100 

false 

DumpData 
Enables ranks to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 
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 Output: 

This predictor outputs a number from 0 to 100 representing the degree to which the 
forecast is bullish or bearish.  A threshold of 90 is recommended for buys and 10 for 
sells. 

Example: 
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Performance: 
The channel neural network predictor which we call “Technical Rank”, was tested over 
the period from 1999 to 2007 on a sample of 500 largest cap stocks on a daily scale.  
The chart below shows the excess (after a random background is removed) percentage 
of winning stocks after 1 to 20 days.  Since the average channel length was 100 days, 
the forecast duration is expected to average about 20% of the channel length.  The 
peak performance is at 18 days and crests at 10% excess winners for both long and 
shorts, when a 10% threshold is used. 

 

 

Name Parameters Direction 
Excess 

%Winners 
Peak 

Duration 
Half-Life 
Duration  

Sample 
Size 

TechnicalRank 
T%>=90%, 
Model=7 Buy 10.88% 18 bars >20 bars 2723 

TechnicalRank 
T%<=10%, 
Model=7 Sell 10.57% 18 bars >20 bars 2723 
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Smart Geometry™
The byproduct of price pursuit is the emergence of self-referential geometry – alias 
geometric price patterns. This tool analyzes sequences of zig-zag price pivots to find 
patterns that are bullish or bearish.  Price, time, volume, and volatility ratios are used to 
train a neural net with the goal of forecasting the strength of the next move. As a 
bonus, I have included traditional geometric patterns such as triangles, pennants, 
wedges, double tops & bottoms, Gartley, crab, shark, bat, etc.  These can be seen as-is, 
OR with our pivot-based net as an overlay to eliminate the less predictive patterns.  No 
testing has been done yet, so proceed with caution.   

PFR Paper:  NA 

TS Name:  PFR_SmartGeometry 

Version:  1.0 

TS Type:  Indicator 

Series:   All market series 

Scale:   All scales except tick    

Recommended Usage: 

Best used as a scalable market direction predictor 

See Also: PFR_SmartChannel 
Maintenance:  None 

Inputs: 

NAME DESCRIPTION DEFAULT 

Min_SmartGeometry_
Rank 

To access our zig-zag neural model use ranks <=100 
98 
(recommended) 

Min_StdPattern_Rank 
To access standard geometric patterns like triangles, wedges, 
crabs, Gartley, and others, us ranks <=100 

101 (turned off) 

RadarScreen_Persist How long (bars) should a signal display up in RadarScreen 50 

DumpData 
Enables ranks to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 

 

 Output: 

This predictor outputs a number from 0 to 100 representing the degree to which the 
forecast is bullish or bearish.  A threshold of 90 is recommended for buys and 10 for 
sells. 
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Chart Examples: 

Neural Net Solution: 

 

Standard Patterns:  

Double Tops and Bottoms, Wedge, Broadening Tops & Bottoms, Head & Shoulders, 
Flags, Pennants, Cup & Handle, Triangles, Gartley 222, Crab, Butterfly, Bat, Shark, 
Cypher, Wolfe, DoubleCross, ABCD, and DoubleDrive 
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RadarScreen Example: 

 
 
 
Performance: 
No tests have been conducted yet, so proceed with caution. 
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Positive Feedback Tools: 
Mapping Extremes 
Detecting the Beginning and End of  Trend Persistent Market 
Phases 

ositive feedback as related to financial markets can be thought of as the 
tendency for investors to chase price without asking too many questions.  
Another term for this is herding, or crowd following.   It is this force that takes 
otherwise tranquil markets to mania highs or panic lows, and it is such a strong 

force that at times virtually no investor can resist its pull.  In Graham and Dodd, they 
spoke about this as “cycles of optimism and pessimism.”   

The mental model for positive feedback then is trend persistency without a 
rational justification.  Price may rise if a market is below fair value, but to continue up 
after surpassing fair value is not justified.  Nevertheless, the crowd is a powerful driver 
of prices at times, and investors are ever enticed to follow the crowd as long as the 
returns are strong.  For this reason we have focused on identifying the ends of these 
crowd-induced price runs. 

Our work shows that the reversal points are anything but random.  Since 
positive feedback is the engine driving prices to extremes, non-linear cycle analysis, 
statistical mechanics, and renormalization group science may be applied to predict 
likely endpoints. 

 

  

Chapter 

P 
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ExtremeHurst™    

We have found that extreme trend persistence creates unstable critical points in 
financial markets, characterized by precursory power law advances or declines 
in price, coupled with converging log-periodic cycles.  These critical points 
mark the end of a trend at a given length scale and are followed by significant 
price reversals of matching scale.  We have created a filter to identify this 
pattern in any price series.  Likewise, extreme levels of mean reversion also 
create unstable critical points characterized by log periodic cycling, and mark 
the beginning of a trend. 
 
TS Name:  PFR_ExtremeHurst 

Version:  7.0 

TS Type:  PaintBar 

Series:   All market series with even time spacing 

Scale:   All scales except tick    

Recommended Usage: 

Best used to identify the beginning or end of trend persistent 
periods. 

Maintenance:  none required 

  
Inputs: 
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NAME DESCRIPTION DEFAULT 

History_OneBar#0_Recent#1_AllBars#2 

Number of bars to analyze for 
signals.  0 means that any signals 
occurring on the last bar should 
be visible.  Select 1 for recent 
signals, and 2 for searching all 
bars (very slow) 

1 

MinRank_R99#0_R95#1_R90#2_R80#3_R70#4_R0#5

Minimum acceptable rank for 
ExtremeHurst signals. Use 0 for 
a 99 minimum, 1 for 95, 2 for 
90, 3 for 80, 4 for 70, and 5 to 
remove all rank filters 

2 (high quality) 

Prefer_SnglBars#0_DblBars#1 

Use 0 to scan displayed bars.  
Use 1 to additionally scan 
doubled bars (means that 2 bars  
are pushed together into 1 bar)  

0          

Plot_Rank_ 

The rank corresponds to how 
well each signal matches an 
ideal ExtremeHurst signal.  
70=Fair, 80=Good, 
90=Excellent 

True 

Plot_Incoming_Cycles_ 
Display the log periodic cycle 
leading into the signal  

True 

Plot_Outgoing_Cycles_ 

Display the log periodic cycle 
tops and bottoms leading away 
from the signal event as a count 
of how many bars until the next 
cycle. 

True 

Plot_Cycle_Countdown_ 
Enter true to count down to the 
next log-periodic cycle turn 

False 

Dump_Data_ 

Enables extension and 
compression signals to be 
written to an ASCII file in the 
C:\Pfr\Dump folder 

False 

HistoryBars_Override 
Override the default number of 
historical bars to search. No 
override if<0 

-1 

HistoryOffset_Override 

Override changes the starting 
point for search by the number 
of bars entered.  No override if 
<0 

-1 

LPCycleAlerts 
Send alerts on expected 
outgoing log-periodic cycle tops 
and bottoms  

true 
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RatioSpreadSymbol 

In Charting: If a second 
symbol is loaded in the chart, 
then it will be used as the 
denominator to find signals on 
the ratio spread.  Activate by 
entering any string (e.g. “ABC” 
or “SPX”) 

In RadarScreen: To set a 
denominator, you may enter the 
name of a data file containing 
Date, Open, High, Low, Close 
comma delimited (.csv 
extension) data in ascending date 
order and residing in 
C:\Pfr\Lists.  Use 
PFR_DumpOHLCV to create 
the file.  Note that scales must 
match numerator symbol 

“ ”  

(empty string) 

Plot_OptionInfo 
Display raw option writing strike 
levels on a chart.  Always 
present in RadarScreen 

false 

CallAwayRate 

The expected percentage of 
times that the recommended 
option strike level will be 
exceeded.  0.15=15% 

0.15 

 
 
Output: 
The magenta bars are “Extension” events and mark the end of trends, while the 
blue bars are “Compression” events and mark the beginning of trends. 
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Examples: 
Our ExtremeHurst filter can be applied to any financial series.  We call the 
critical points at the tops and bottoms of power law moves “extensions.”  
Additional critical points are found corresponding to extreme mean reversion.  
Some signal examples are shown in the following charts: 
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Extensions 

Compression 
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In RadarScreen: 

 

In Nightly Email Report: 

As a convenience for our Platform users, we produce and email an ExtremeHurst 
signal list each night containing new daily signals.  On Friday, the list also contains 
weekly scale signals, and at month end, an additional list of monthly scale signals.  
The universe for this list spans multiple security types and countries.  In many cases 
TradeStation may not have these securities.  Here is an example from the Jan 29th 
email: 
 
ExtremeHurst Analyst  2021-01-29   (v7) 
============================================================= 
 
Bottom Extensions (daily scale) 
------------------------------- 
[equity]    PTVE (PACTIV EVERGREEN INC) 
[index]     IRX (CBOE 13-WEEK YIELD) 
[index]     ^FTIC (FTSE ALL SHARE INSURANCE) 
[index]     ^PSI (PHILIPPINES PSE COMPOSITE INDEX) 
[index]     ^PSPR (PHILIPPINE SE PROPERTY INDEX) 
 
Top Extensions (daily scale) 
---------------------------- 
[equity]    ACRS (ACLARIS THERAPEUTICS INC) 
[equity]    DNMR (DANIMER SCIENTIFIC INC) 
[equity]    EBIX (EBIX INC) 
[equity]    GME (GAMESTOP CP) 
[equity]    LGND (LIGAND PHARMA) 
[equity]    RAD (RITE AID CORP) 
[index]     SPSMCMS (S&P SMALLCAP RETAILING INDUST GROUP) 
[index]     SPSMCSPR (S&P SMALLCAP SPECIALTY RETAIL INDUST) 
[etf]       CLAYF (ISHARES 15 YEAR) 
[etf]       CLFMF (ISHARES 115 YEAR LADDERED BOND ETF) 
 
Compressions (daily scale) 
-------------------------- 
[equity]    ARI (APOLLO COMMERCIAL REAL ESTATE FINANCE) 
[equity]    BRMK (BROADMARK REALTY CAP INC) 
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[equity]    BXMT (BLACKSTONE MORTGAGE TRUST INC) 
[equity]    CHWY (CHEWY INC) 
[equity]    CNP (CENTERPOINT ENERGY) 
[equity]    DBX (DROPBOX INC) 
[equity]    EGBN (EAGLE BANCORP INC) 
[equity]    ESS (ESSEX PROPERTY TRUST) 
[equity]    EXR (EXTRA SPACE STORAGE INC) 
[equity]    GD (GENERAL DYNAMICS) 
[equity]    GOOD (GLADSTONE COMMERCIAL CORP) 
[equity]    JLL (JONES LANG LASALLE INC) 
[equity]    MLHR (HERMAN MILLER INC) 
[equity]    MO (ALTRIA GROUP) 
[equity]    MUR (MURPHY OIL CORP) 
[equity]    NOW (SERVICENOW INC) 
[equity]    O (REALTY INCOME CORP) 
[equity]    PPC (PILGRIM'S PRIDE CORP) 
[equity]    PPL (PP&L CP) 
[equity]    RVMD (REVOLUTION MEDICINES INC) 
[equity]    SRC (SPIRIT REALTY CAPITAL INC) 
[equity]    T (AT&T INC) 
[equity]    TBI (TRUEBLUE INC) 
[equity]    ZM (ZOOM VIDEO COMMUNICATIONS INC) 
[index]     DJU52 (DJUSFC - DJ US FIXED LINE COMMUNICATIONS) 
[index]     DJU96 (DJUSPB - DJ US PUBLISHING INDEX) 
[index]     SPCOMALI (S&P 1500 AIRLINES INDUST) 
[index]     SPCOMDIFN (S&P 500 DIV FINL) 
[index]     SPCOMMED (S&P 1500 HC EQUIP SUB-INDUST) 
[index]     SPLRCAIR (S&P AIRLINES SUB-INDUST) 
[index]     SPLRCHCEQ (S&P 500 HEALTH CARE EQPT. & SUPPLIES IND) 
[index]     SPLRCMED (S&P 500 HEALTH CARE EQPT. SUBIN) 
[index]     SPLRCREIO (S&P OFFICE REITS) 
[index]     SPLRCTOBA (S&P 500 TOBACCO IND) 
[index]     SPMDCAIR (S&P MIDCAP AIRLINES SUB-INDUST) 
[index]     SPMDCALI (S&P MIDCAP AIRLINES INDUST) 
[index]     SPSMCREII (S&P 600 INDUSTRIAL REITS SUB-INDUST) 
[index]     ^BUK250N (BATS UK 250 NTR) 
[index]     ^BUK250P (BATS UK 250 PR) 
[index]     ^C1000P (SWX ID BASICMAT PRICE INDEX) 
[index]     ^C1000T (SWX ID BASICMAT TOTAL RETURN INDEX) 
[index]     ^C1300P (SWX SP CHEMICALS PRICE INDEX) 
[index]     ^C1300T (SWX SP CHEMICALS TOTAL RETURN INDEX) 
[index]     ^FRBM (CAC BASIC MATERIALS 1000) 
[index]     ^FTAF (FT GOLD MINES AFRICA INDEX) 
[index]     ^FTE1300 (FTSEUROFIRST SS CHEMICALS) 
[index]     ^FTE3500 (FTSEUROFIRST SS FOOD & BEVERAGE) 
[index]     ^FTE3700 (FTSEUROFIRST SS PERSONAL & HOUSEHOLD GOO) 
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[index]     ^FTE3X3000 (FTSE E300 CONSUMER GOODS) 
[index]     ^FTE5500 (FTSEUROFIRST SS MEDIA) 
[index]     ^FTFN13C (FTSE NAREIT INDUSTRIAL OFFICE CAPPED IND) 
[index]     ^FTNMX5550 (FTSE 350 MEDIA) 
[index]     ^FTUB5500 (FTSE 350 SS MEDIA) 
[index]     ^HEX (FINLAND HELSINKI GENERAL INDEX) 
[index]     ^J378 (FTSE JSE TOBACCO INDEX) 
[index]     ^JELEE (JSE ELECTRONIC & ELECTRICAL EQUIPMENT) 
[index]     ^OMXHBCAPGI (OMX HEL BM CAP G) 
[index]     ^OMXHBCAPPI (OMX HEL BM CAP P) 
[index]     ^OMXHGI (OMX HELSINKI_GI) 
[index]     ^SPBLMPT (S&P/BVL MINING INDEX) 
[index]     ^SXRP (STOXX EUROPE 600 RETAIL EUR PRICE INDEX) 
[index]     ^TS30 (S&P TSX PAPER AND FOREST PRODUCTS) 
[etf]       ISHBF (ISHARES DLR TREASURY BOND 20+YR UCITS ET) 
[etf]       ISRUF (ISHARES V S&P 500 FINACIAL SECTOR ETF) 
[etf]       JXI (ISHARES GLOBAL UTILITIES ETF) 
[etf]       LOWC (SPDR MSCI ACWI LOW CARBON TARGET ETF) 
[industry]  M05 (Soaps/Cosmetics) 
[future]    @@S (Soybeans) 
[future]    @@W (Wheat) 
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Performance:  
 
The following chart summarizes average excess win rate% for version 7.0 of 
ExtremeHurst over many time periods, securities, and scales.  The negative values are 
for sell indications (Top Extensions or Compressions breaking down).  For example, a 
20% edge means that following the signal, there is a 50% (random) + 20% (edge) = 
70% chance of moving away from the signal price. 

Version 7.0 Signal Performance  
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Research History: 
This section covers the basic science and the empirical results from our 

ExtremeHurst™ market predictor model.  Our research started in the late 80’s 
with the observation that market series appeared to have no unique trend.  An 
uptrend on a 5 minute chart might be embedded in a daily scale downtrend, and 
a monthly scale up trend, etc.  It also made intuitive sense that no unique trend 
exists.  After all, if it did, then all investors would quickly exploit it for profit.  
So following this line of thought, we wondered what would happen next if a 
financial series simultaneously showed a measurably strong trend on at least 
two adjacent time scales, or even three.  This is a deceptively simple question, 
but how is trend measured?  How much trend is a strong trend?  Are there 
preferred time scales?  How much data is needed to evaluate trend?  The 
answers to these questions led eventually to the discovery that elements of 
chaos theory, namely self-organized criticality [13, 30] and discrete scale 
invariance [25-27, 30] (discovered independently and named by Didier 
Sornette), have a statistically significant predictive power in financial markets 
and elsewhere.  Here are the highlights of the journey. 
 

Most scientists and engineers graduating in the 80’s or earlier were 
trained that experimental data usually approximated some smooth function, but 
with a bit of random measurement error.  To the untrained eye, stock price data 
looks very similar to a smoothly trending signal covered up by a large amount 
of random noise.  Even the price return distribution resembles a normal 
distribution, which implies a random process.  The standard engineering 
approach in cases like this would be to fit a regression curve to the market 
series and write off the remainder to random noise [1].  Once a smooth curve 

was found that fit prices well enough, one would just find the slope (“trend”) at 
each point.  The trend would be unique by definition, and its direction would 
dictate the trade direction.   
The figure above shows a typical regression curve fitted to data with the 
remainder attributed to random sources 

 
If this sounds too simple to be true, you have graduated to the rest of the 

story.   
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Chaos theory covers the dynamics of feedback systems [3, 8, 12, 18, 22, 
30, and 31].  Generally, feedback means that the outputs of the system are fed 
back into the system as new inputs to produce more outputs….and then this 
process continues until the loop is broken.  Feedback can be negative, like in 
the case of a thermostat, or positive, as seen by placing a microphone near a 
speaker.  In the financial markets we can imagine that price movement, news, 
or possibly influential people produce investment bias “output” that is fed into 
the brains of the investor community, who then produce new outputs in the 
form of buy and sell decisions.  If this bias is positive, buying occurs, which 
leads to higher prices and more positive bias, etc.  Feedback systems exhibit 
certain characteristics, which strangely enough, seem to match the kinds of 
phenomena that market technical analysts have attributed to markets over the 
last 100 years.  Self-similarity is the primary example. 
 

Financial series appear to have the same "look" on many different time 
scales.  This is called self-similarity, and it happens to be one of the best ways 
to confirm that a series is governed by the rules of chaos theory.  Put another 
way, the market appears to be what Mandelbrot [14] called a “fractal.” Not 
quite like a fern or a snowflake, but more of a statistical fractal like a shoreline.  
We chose a fractal function developed by Weierstrass to model a market series 
[8].  Weierstrass functions are continuous, meaning you can draw one without 
lifting your pencil, but they have no unique slope.  They look like a cycle inside 
a cycle inside a cycle as shown in the next figure.  Market technicians call this 
effect the “Elliot Wave”, but self-similarity has a much deeper theoretical 
meaning firmly based in non-linear dynamics. 

 
Weierstrass functions[8] show nested cycle patterns.  It has no unique slope at any point.  Equation: 

   ttf k

k

ks  sin)(
1

2




 , 1<s<2, 1  

According to our model, a 5 minute chart will exhibit a different slope at a 
given moment than the same chart viewed on a 60 minute, daily, weekly, or 
monthly scale.  It all depends on the length of your time sampling.  Again, this 
is nothing new to traders, but it represents a radical shift for scientists and 
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engineers.  Faced with a non-unique trend, we decided to make multiple 
measures of trend on different scales.  This naturally led to the research 
question of what might happen if they all agreed. 
 
Theoretical Considerations: 
 

To measure trend we used a special scale-limited form of the Hurst 
exponent [35].  The Hurst exponent has a simple formula and ranges in value 
between 0 and 1.  Values above ½ indicate that there is a trend to events, with 
very high values (towards 1) corresponding to strong trends, with a marked 
tendency to persist.  Values below ½ correspond to mean-reverting behavior, 
which becomes more and more tightly constrained as the exponent approaches 

0.   The formula for the exponent is:  

Where  is the range of the cumulative deviations from the mean divided by 
the standard deviation, c is a constant and H is the Hurst exponent.  The following 
picture shows the Hurst exponent placed on a percentile rank scale of our choosing. 

 
This figure shows the Hurst exponent percentiles and our 
interpretation of the various domains.   

The following picture is an example of what a time series might look like using 
different Hurst exponents [34]: 
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Using the Hurst exponent, we are able to identify price swings which have high 
autocorrelation and resemble power law upswings or downswings such as the one 
shown in the following picture [30]:  

 

There was another key timing factor in addition to the parabolic price move 
which we literally stumbled upon while trying to limit our Hurst sampling.  Cycles were 
present during these parabolic moves, and by exploiting them, we were better able to 
time the critical point.  These cycles were the key to confirming that markets are 
actually Complex Fractals instead of the real-numbered fractals of Mandelbrot.  The 
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next section discusses how the discovery of log periodic cycles ties to the science and 
yields truly remarkable results, while explaining so many technical analysis “mysteries”. 

Extremes of investor behavior are most evident in large scale market manias or 
crashes, but like earthquakes, significantly more low magnitude events occur than large 
ones.  It is our contention that markets set themselves up in critical states through 
feedback, like earthquakes, and then we see tremor-like activity of all sizes and scales at 
both highs and lows.  This area of scientific research is called “Self-Organized 
Criticality” or SOC for short. Bak, Tang, and Weisenfield (BTW) [36] first introduced 
SOC in 1987 by studying the occurrences of avalanches in sand pile models.  It was 
their contention that large systems with many constituent parts, organize themselves 
into states that resemble systems in equilibrium at critical points.   

In the case of the markets, investors are influenced by news, price changes, and 
other investors within their local social network.  This influence conditions their 
willingness to buy or sell, which in turn affects price and influences others, and so on.   
One of the methods used to understand the dynamics of large critical systems is called 
the Renormalization Group Method [10, 13, 27, 30] this method uses scaling to make 
sense of complex systems.  Temperature is an example of this idea.  We wouldn’t think 
of tracking each air molecule to calculate heat (except maybe in a physics lab), so we 
characterize the behavior of a large group of molecules instead by their temperature.  
We have applied this same method to learn some basic principles about markets:  First, 
it takes very few net buyers or sellers to trigger a buying or selling trend, or end one.  
Second, the buildup to a critical point resembles the power law function      C1*(1- 
t/tc)x , where C1 is a constant, x is a negative power, t is time, and tc is the time of the 
critical point.  Thirdly, price movements exhibit the dynamics found with complex-
numbered fractals, much the same as in diffusion-limited aggregation.  The complex 
part of the dimension yields a log-periodic ripple in price that converges to the critical 
point (and diverges away from it) that has the form:  1+C2*cos[ p*ln(1- t/tc)+q ] , 
where ln(x) is the natural log function, cos(x) is the cosine function, and C2, p, and q 
are real constants[30].    

In the time domain the small ripple signal we search for looks like this: 
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While in the log time domain it becomes a sine wave:  

 
Sornette [26] attributes this ripple to what he has called “discrete scale invariance” which means that the price series is only scale 
invariant at certain discrete times.  He attributes this effect to fractal dimensions being complex numbers instead of real numbers.  
Translation: Discrete scale invariance occurs when all trend measurements at all scales agree with each other.  Our filter is designed to 
find these critical points. 

The filter we have created finds these critical points at the end of power law advances 
and declines.  These we call “extensions.”   

 
 
There is another critical point not yet written about in the literature that we call 

“compressions.”  A compression has the same log periodic behavior shown above, but 
without the power law advance or decline.  A compression occurs at points of extreme 
mean reversion, and is followed by the start of a new trend. 
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60 minute and 15 minute scale compressions 
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HurstFur™ 
TS Name:  PFR_HurstFur 

Version:  2.0 

TS Type:  Indicator 

Series:   All market series 

Scale:   all scales except tick    

Recommended Usage: 

Best used to identify times when the Hurst Exponent is 
almost the same on multiple scales.  At these times prices 
become unstable 

Maintenance:  none required 

See Also: none  

Inputs:  ShowAverage Displays average Hurst value like the retired HurstTracker did,   
default is false 

 

Output: 
The output is a series of colored columns representing the Hurst Exponent at 
different scales.  The shortest scales are on the bottom.  Colors are as follows:  
red represents persistent down trends. Green represents persistent up trends.  
Gray shows random price movement, and blue represents mean-reverting price 
action. 
  
Example: 
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Precision Turn™ 

Evidence for Cycles  

Any discussion of cyclic behavior usually begins with a display of 
unexplained peaks in the frequency spectrum of the time series in question.  
The Fourier transform is used to build the amplitude versus frequency picture 
of the target time series.  If all frequencies were equally represented then the 
graph would be flat and featureless.  If however some frequencies were very 
strong, a large amplitude spike would appear in the graph.  This would have to 
be explained by some phenomenon that occurs regularly and is stationary over 
time.  
 

The Dow Jones daily financial series was analyzed from 1885 to 1998 
in this manner and a number of unexplained spectral peaks emerged as shown 

below:   
        Figure 7. DJIA frequency response spectrum for 100 years of daily data 
 

Over the years economists have attributed these peaks to the election 
cycle, business cycle, calendar year, and earnings season, and others.  We have 
also found these peaks, but have found that the quasiperiodic oscillator model 
from chaos theory can be used to explain many of them.  We have also learned 
that the relationship between the peaks produces unstable phase behavior.  To 
put this simply, we can use the cyclic pattern to forecast trend changes, but 
cannot know in advance whether a trend change will be at a high or a low.    
 

To predict these unstable cycles we created the “Turn Measurement 
Index” or “TMIw”, which measures the scale independent absolute value of the 
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price series curvature.  In other words, when the market makes a significant 
high or low, our TMIw shows a high value.  When prices are steadily moving 
up, down, or sideways, TMIw is at or near zero.  

TMIW is a way of representing the most predictable part of financial 
cycle forecasting.  In the next section we will discuss one way to use lagged 
TMIW measurements to forecast today’s TMIW, or trend change potential, using 
neural networks. 
 
Forecasting TMI with Neural Networks 

There are numerous ways to build TMIw forecasts using historical price 
data.  A simple Fourier approach is probably the most widely used technique 
for cycle analysis.  Parallax uses a proprietary algorithm, but I will demonstrate 
a simple method for using neural networks to generate future TMIw numbers.  
First, we built a TMIw series using Microsoft stock.  Then we lagged that series 
a number of times to use as training inputs.  The lagged TMIw’s were fed into a 
network training program with the target being today’s TMIw.   
 
The next picture shows an example of predicted versus actual TMIW using a 
simple neural network with 14 lagged inputs of TMIW .   

 
 Precision Turn™ uses TMIw and a proprietary cycle finding method to 
predict future trend change dates for daily and weekly price series.   
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PFR Paper:  Measuring the Statistical Significance of Financial Trend 
Change Forecasts 

TS Name:  PFR_PrecisionTurn 

TS Type:  PaintBar 

Series:   All market series 

Scale:   D | W only    

Recommended Usage: 

Best used to identify expected market trend change dates. 
Direction is marked at the time of the signal based on the 
incoming trend. 

Maintenance:  none required  
Inputs: 

NAME DESCRIPTION DEFAULT 

FutureTurnsToList How many future turns to list in the text area 3 

ShowTurnSize Display a number from 0 to 100 representing the turn rank false 

DumpData Writes the turn forecasts to file in the C:\Pfr\Dump folder false 

ShowFlatTurns Show turns where no prior trend has been measured true 

RunYearOverride 
This allows you to set the last year that data will be used 
for cycle analysis (where out of sample begins) 

-1 

 
Output: 

Precision Turn does not forecast direction, so a trend measurement is 
made on the day of the turn using a local Hurst exponent.  If a trend is present 
then a top or bottom arrow is plotted on the chart to designate a forecast turn.  
A “*” sign is made to designate that no trend proceeded the forecast turn. Turns 
are calculated using many years of data, with two years held in reserve for 
testing. 
 A statistical t-test is run on the out-of-sample turn forecasts displayed.  
We find that if the “p-value” shown is below 0.3 then the turns have generally 
been well timed.   
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Chart Screen: 

 
 
RadarScreen: 

  

Performance: 
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VolumeTrend™
Complexity Theory tells us about the dynamics of multi-agent systems, where a 

few simple rules can lead to very complex-looking emergent behavior (like flocking 
birds).  If we consider investors and traders as "agents", the simple rules are to these:  
1) Pursue price trends (positive feedback), and 2) Be attracted or repulsed at prices that 
are related geometrically to previous prices (support/resistance).  Those two rules give 
us the behavior cited by technical analysts.   

The VolumeTrend index line is a better surrogate price series, as it has been 
adjusted for rule 1.  When investors chase price, they will only do so in the direction 
they perceive there to be a trend on their scale, and when they do, volume increases.  
The VolumeTrend line moves only when the volume on any of several scales is 
increasing (cases A and C below), with the net up or down price changes being applied 
to form the index. If volume decreases, the line stays flat and bars are colored gray.  We 
have found that increasing volume with increasing price leads to significant upward 
trends, while increasing volume and decreasing price leads to significant downward 
trends. Sampling on multiple scales greatly improves this effect.  Note that 
VolumeTrend may give clues to which way a Compression may go. 

 

When price moves up or down, but VolumeTrend does not, a divergence sets 
up, indicating a retracement in a trend is occurring that will likely fail if it goes too far.  
We display a divergence signal once this condition reaches an extreme.     
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TS Name:  PFR_VolumeTrend 

TS Type:  PaintBar  

Series:   all markets 

Scale:    all time scales   

Recommended Usage: 

Best used to help identify and ride a trend persistent price 
move.  VolumeTrend is designed to be a better price series by 
emphasizing price moves accompanied by increasing volume, 
while ignoring price moves with decreasing volume.   

Maintenance:  none required 

Inputs: 

NAME DESCRIPTION DEFAULT 

HistoryBars 
The number of historical bars on which to calculate and 
display results 

500 

Speed_Slow_Med_Fast 
Controls the volumetrend filter length.  Choices are 
“Slow”, “Medium”, or “Fast” 

“Medium” 

DivergenceAngleTrigger 
Max angular (degrees) separation between the volumetrend 
and price trend that will signal a divergence  

14 

RatioSpreadSymbol 

In Charting: If a second symbol is loaded in the chart, 
then it will be used as the denominator to find signals on 
the ratio spread.  Activate by entering any string (e.g. 
“ABC” or “SPX”) 

In RadarScreen: To set a denominator, you may enter the 
name of a data file containing Date, Open, High, Low, 
Close comma delimited (.csv extension) data in ascending 
date order and residing in C:\Pfr\Lists.  Use 
PFR_DumpOHLCV to create the file.  Note that scales 
must match numerator symbol 

“” (empty string) 

DumpData 
Enables the ranks to be written to an ASCII file in the 
C:\Pfr\Dump folder 

False 

 
  

P F R  N A M E :  

VOLUME TREND 
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RadarScreen: 

 
 
 
Chart: The pictures below shows price and the corresponding VolumeTrend line, 
painted bars, and occasional divergence signals: 
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Edge Performance: 
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RSIz™.
This version of relative strength simply counts the number of up and down bars 
within the most recent N bars and performs a simple statistical test on the 
result. It assumes that up and down bars have equal probabilities of occurrence.  
A reading above or below the lines drawn on the chart indicate a statistically 
significant deviation from random has occurred 

PFR Paper:  NA 

TS Name:  PFR_RSIz 

TS Type:  Indicator 

Series:   All market series 

Scale:   all scales  

Recommended Usage: 

Best used to distinguish between trending and non-trending 
price action 

Maintenance:  none required 

Inputs: 

NAME DESCRIPTION DEFAULT 

HistoryBars Number of bars to process for historical results 500        

SampleLength Number of historical prices to sample 14 

SignalRate Rate of desired signal occurrence as a percentage (5%=0.05) 0.03 

Annotate Annotate the RSIz reading at the end of the price chart display False 

DumpData Enables the results to be written to an ASCII file in the C:\Pfr\Dump folder False 
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Output: 

 

The RSIz is shown by a bullish-to-bearish colored line below the price chart.  
 
Performance: 

Name Parameters Direction 
Excess 

%Winners 
Peak 

Duration 
Half-Life 
Duration  

Sample 
Size 

PFR_RSIz 
z<=-1.96 (5%) 

daily Buy 3.84% 9 days 13 days 2543 

PFR_RSIz 
z>=1.96 (5%) 

daily Sell 6.67% 4 days 13 days 3787 

PFR_RSIz 
z<=-1.96 (5%) 

weekly Buy 2.73% 8 weeks 
12 

weeks 615 

PFR_RSIz 
z>=1.96 (5%) 

weekly Sell 4.39% 8 weeks 
11 

weeks 2119 
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Price Volume Cross
Price volume crossovers patterns are an attempt to capture a pattern of crowd 
investment behavior prior to a significant rise or fall in prices.  Marc Chaikin and I 
studied 24 of these patterns and found 4 that were significant.  They are located using 
this indicator.  The plot below shows how a price view and volume view of stocks may 
be combined into a “price-volume” view. 

 

PFR Paper:  Forecasting Stock and Commodity Prices using Price-
Volume Crossovers, Kaufman and Chaikin, MTA Journal, 
1991 

TS Name:  PFR_PriceVolumeCross 

Version:  2.0 

TS Type:  ShowMe 

Series:   All market series (except pre-spread series like FX) 

Scale:   all scales  

Recommended Usage: 

Best used as to identify significant upcoming directional price 
movement 
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Maintenance:  none required 

Inputs: 
 

NAME DESCRIPTION DEFAULT 

History_Bars Number of historical bars to process for signals 200 

RadScrPersist The number of bars a signal will persist on RadarScreen 10 

DumpData 
Enables results to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 

 
Output:  

 
 
The red dots mark bearish predictions as of the close of the bar where they are 
plotted, while the green dots mark bullish predictions. 
 

Performance: 
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Price Volume Alert
The psychology of market players is occasionally revealed by unusual price and volume 
activity.  We typically see these anomalies at price extremes, just as the market is about 
to enter a new stage.  What constitutes a price or volume anomaly?  In order to identify 
an anomaly we first have to determine what is normal.  We chose to study relative 
anomalies such as how different the most recent N-day average volume and range is 
from the average volume and range in the preceding N-days.  A neural net was trained 
to recognize when the interaction of relative range and volume precedes a period of 
range expansion (increased volatility) either up or down. 

PFR Paper:  NA 

TS Name:  PFR_PriceVolumeAlert 

TS Type:  PaintBar 

Series:   All market series with volume 

Scale:   all scales  

Recommended Usage: 

Best used to predict increases in volatility 

Maintenance:  none required 

Inputs: 

 

NAME DESCRIPTION DEFAULT 

Chart_HistoryBars Number of bars over which to run this indicator on a chart 500 

RadarScreen_HistoryBars
Number of bars over which to run this indicator within 
RadarScreen 

20 

DumpData 
Enables the results to be written to an ASCII file in the 
C:\Pfr\Dump folder 

False 
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Output: 

A red PaintBar is drawn if a signal is detected.  Testing on 9180 daily stock signals over 
20 years shows a 17% expansion in volatility.  These signals tend to happen at market 
trend changes. 

 

 

Performance: 

 

Name Parameters Direction Amount Duration 
Sample 

Size 

PVAlert Set internally 
Volatility 
Increase 17% 20 days 9180 
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H Bands
The Hurst Bands are a replacement for standard deviation (Z)-based models such as 
Bollinger. We plot the price at which the market would have achieved a given Hurst 
Exponent value, at intervals of 0.05 from 0.05 to 0.95.  We have signed these bands to 
represent up and down moves.  Hurst is meaningful.  Price is said to be trend 
persistent when in the green or red bands, ripe for a reversal beyond the magenta band, 
or mean reverting in the blue bands. The best trend, up or down, occurs roughly 
between 0.52 and 0.72. 

TS Name:  PFR_H Bands 

TS Type:  Indicator 

Series:   all series 

Scale:   all scales   

Recommended Usage: 

Best used to detect short term trend persistency 

Maintenance:  none required 

Inputs:    

NAME DESCRIPTION DEFAULT 

HistoryBars Number of bars to plot bands 500 

ColorDensity_0_to_1 
Vary the opacity of the bands from 0 (invisible) to 1 (fully 
opaque) 

0.30 

DumpData 
Enables the results to be written to an ASCII file in the 
C:\Pfr\Dump folder 

False 
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Chart Output: 

 

RadarScreen Output: 

 
 

Performance: 
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Confluence™
Our confluence tool blends the predictive edges from seven different indicators 
sampled on four different time scales to produce an estimated composite “net” edge.  
The indicators include ExtremeHurst, SmartChannel, Precision Turn, VolumeTrend, 
HBands, Price-Volume Cross, and RSIz.  The scales are multiples of the base time 
period (bar interval) being examined.  Multiples include 1, 2, 3, and 5 times the base 
period.  Resulting edges are displayed 1, 3, 5, 10, and 15 bars forward.  Early results 
show that a reading beyond +/- 23% is very significant.    

PFR Paper:  NA 

TS Name:  PFR_Confluence 

TS Type:  Indicator (RadarScreen only) 

Series:   All market series 

Scale:   all scales  

Recommended Usage: 

Best used to predict near term direction 

Maintenance:  none required 

Inputs: 

 

NAME DESCRIPTION DEFAULT 

RunDate_YYYMMDD
Date on which to run confluence.  The default is always the 
current day 

0 

DumpData 
Enables the results to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 

DumpEvery When dumping data, how many bars to skip between samples 1 
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Output: 

Confluence runs only in RadarScreen and is extremely CPU intensive.   

 

Performance: 

Analysis is still in progress and final results are expected by late Jan 2022.  Early results 
show a significant advantage for edges at or beyond 25% from at least 6 non-zero edge 
contributions. 
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Fusion: Combining Predictors 
How To Build More Powerful Predictors & Complete Investment 
Management Systems 

ombining predictors is a powerful way to build complete investment 
strategies.  Parallax uses the platform tools to build or enhance investment 
management systems for our clients under separate consulting and profit 
sharing arrangements.  Here are a few example indicators that combine other 

platform predictors: 

F & T (2 separate tools)
It turns out that averaging our Fundamental Rank and Technical Rank indicators is a 
good way to screen stocks.  A variant of this model has been used successfully by one 
of our clients to manage money since the early 1990’s. 

TS Name:  see PFR_FundamentalRank and PFR_TechnicalRank 

TS Type:  Indicators 

Series:   US Equities 

Scale:   D | W    

Recommended Usage: 

Best used to screen US stocks for expected performance 

Maintenance:  Price Wizard database updated monthly 

Inputs: see each indicator 

 
  

Chapter 

C 
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Output: 

 

Performance: 

Name Parameters Direction 
Excess 

%Winners 
Peak 

Duration 
Half-Life 
Duration  

Sample 
Size 

F & T (F+T)/2 >=90 Buy 11.61% 
30 

weeks 
>30 

weeks 
7755 

weeks 

F & T (F+T)/2 <=10 Sell 8.13% 8 weeks 22 weeks 
2681 

weeks 
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Forecasters™
This is a new agent-based model which incorporates trend persistence, fundamental 
valuation, and counter-trend methods.  Each of 1000 agents is randomly assigned a 
blended trading strategy and money to manage.  Each time step the agents use their 
assigned models to go long or short, and are rewarded or penalized based on 
performance.  The aggregate weighted vote and the vote by the highest performing 
agent is made available and plotted on the screen.   

TS Name:  PFR_Forecasters 

TS Type:  Indicator 

Series:   all series 

Scale:   all scales   

Recommended Usage: 

Best used to predict likely market direction 

Maintenance:  Price Wizard database updated monthly (optional ) 

Inputs: 

NAME DESCRIPTION DEFAULT 

TrendFollowingOn Toggle the trend following investment method on or off true 

MeanReversionOn Toggle the mean reversion investment method on or off true 

FundamentalOn Toggle a fundamental investment strategy on or off true 

DumpData 
Enables the ranks to be written to an ASCII file in the 
C:\Pfr\Dump folder 

false 
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Output: 
 

 
 

Performance: 

Name Parameters Direction 
Excess 

%Winners 
Peak 

Duration 
Half-Life 
Duration  

Sample 
Size 

Forecasters 

weekly, all 
methods,p<0.01,weighted 

vote>20% Buy 3.79% 
28 

weeks 
>30 

weeks 
3009 

weeks 

Forecasters 

weekly, all 
methods,p<0.01,weighted 

vote<-20% Sell 2.60% 
28 

weeks 
>30 

weeks 
4326 

weeks 
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Multi-Scale Strategic 
Forecasting 
Development of  Multi-Market and Multi-Scale Strategic 
Forecasts   

he solutions platform tools may be used on multiple markets and on multiple 
time scales to build up a comprehensive forecast and strategic investment or 
trading plan.  In this chapter I will attempt to develop the guidelines for 
developing such a plan, and show a couple of historical examples.   

There are three basic steps necessary for plan development, and they correspond to 
evaluating our predictors at progressively smaller time scales: Context, Strategy, and 
Positioning.  At each of these scales, trading plan reinforcement is found by consulting 
multiple related market series and multiple predictors for confirmation. 

Context Time Frame 

The “Context” time frame is the highest time frame you will refer to when developing 
a plan.  It corresponds to 4-5 times the length of your investment/trading time frame.  
For example, if you will be trading on a daily scale, then the “Context” time frame 
should be weekly.  Our predictors each are effective for a certain duration, after which 
their effect diminishes.  If you need to hold a position for a year for instance, then a 
weekly investment scale would be more suitable, with the Context time frame being 
monthly.  If you trade 5 minute E-Minis, then a 20 to 30 minute Context time frame is 
recommended. 

Context  

The term “Context” as it is used here, refers to the state of the target financial series at 
a higher scale than planned trading.  The figure below is described in Chapter 2 as it 
pertains to theoretical market dynamics.  We are now going to get very specific and try 
to identify the target market states as numbered in the diagram from 1 to 7.  These 
states will set the Context for a trading/investment plan. 

Chapter 

T 
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1. Bottom Extension: 

A bottom extension occurs at the end of a downtrend and forecasts a period of 15 to 
20 bars of sideways to up price action with decreasing volatility.  In short, a bottom 
extension sets the trading context to counter-trend, where the best strategy is to sell 
short highs and buy lows.  The first   move from a top extension is usually down, so 
any trading plan should incorporate this as a first trade.  An extension is identified 
using PFR_ExtremeHurst on the target market.  As a surrogate for a true extension, 
the PFR_HBands may be used with a reading above or below the magenta bands.   

PFR_PriceWizard or PFR_FundamentalRank may be used to reinforce the bottom 
extension if it’s found that the target market is undervalued.  If a stock is overvalued, 
then an extension may be only an acknowledgement that the crowd of investors has 
finally realized its value. 

2. Mean-Reverting at Bottom/Lows 

After a bottom extension has “worked off” for 15-20 bars, a market may be mean 
reverting, or just be moving randomly.  Prior to an extreme low Hurst reading (See 4), 
the trading context is either random or counter-trend.   Fading support and resistance 
lines, whether horizontal as given by PFR_PriceMemory, or sloped as given by 
PFR_SmartChannel is generally the best strategy.  

3. Trend Persistent Downward 

A trend persistent down period is characterized by a clear jump in PFR_HBand 
numbers across the band from mid-band numbers or a recent compression (See 4).  
Use the PFR_VolumeTrend paintbar study along with PFR_PriceMemory and 
PFR_SmartChannel to confirm and ride the trend.  Trends can last a significant length 
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of time, so your investment/trading window length should be open ended.  Restrict 
your Strategy to short trades. 

4. Compression 

A compression occurs just prior to the beginning of a new trend and signals a period 
of 15 to 20 bars of up or down trend price action.  In short, a compression sets the 
trading context to emergent trend, where the best strategy is to trigger into a long 
trade on strength or trigger short on the first signs of weakness.  A compression is 
identified using PFR_ExtremeHurst on the target market.  As a surrogate for a true 
compression, the PFR_HurstFur may be used with consistent reading at or below 0.05 
(blue color).  Trigger levels for the following emergent trend may be found using 
PFR_PriceMemory or PFR_SmartChannel.  Once the new trend has begun, use the 
midpoint of the compression bar as the critical reversal price level.   

PFR_PriceWizard or PFR_FundamentalRank may be used to reinforce a compression 
if it’s found that the target market is breaking toward its valuation.   
PFR_PrecisionTurn or PFR_PriceVolumeAlert may signal at approximately the same 
time as the compression, and would confirm its timing. 

5. Trend Persistent Upwards 

A trend persistent upward period is characterized by a clear jump in PFR_HBand 
numbers across the green band from low numbers or a recent compression (See 4).  
Use the PFR_VolumeTrend paintbar study along with PFR_PriceMemory and 
PFR_SmartChannel to confirm and ride the trend.  Trends can last a significant length 
of time, so your investment/trading window length should be open ended.  Restrict 
your Strategy to long trades. 

6. Mean-Reverting at Top/Highs 

After a top extension has “worked off” for 15-20 bars, a market may be mean 
reverting, or just be moving randomly.  Prior to an extreme low Hurst reading (See 4), 
the trading context is either random or counter-trend.   Fading support and resistance 
lines, whether horizontal as given by PFR_PriceMemory, or sloped as given by 
PFR_SmartChannel is generally the best strategy.  

7. Top Extension 

A top extension occurs at the end of an uptrend and signals a period of 15 to 20 bars 
of sideways to down price action with increasing volatility.  In short, a top extension 
sets the trading context to counter-trend, where the best strategy is to sell short highs 
and buy lows.  The first   move from a top extension is usually down, so any trading 
plan should incorporate this as a first trade.  An extension is identified using 
PFR_ExtremeHurst on the target market.  As a surrogate for a true extension, the 
PFR_HBand may be used with a reading above the magenta top band.   
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PFR_PriceWizard or PFR_FundamentalRank may be used to reinforce the top 
extension if it’s found that the target market is overvalued.  If a stock is undervalued, 
then an extension may be only an acknowledgement that the crowd of investors has 
finally realized its value. 

 

Strategy & Positioning 

The term “Strategy” as it is used here refers to the specific trading plan for the target 
financial series on a time frame that is roughly a factor of 5 smaller than the Context 
time frame. The term “Positioning” is done on an even smaller time frame (factor of 4-
5 also), such that the best advantage is taken of the Strategy.  The following table lists 
the Context categories from the previous section, and the Strategy and Positioning 
rules that are recommended. 

Context (Monthly*) Strategy (Weekly) Positioning (Daily) 

Counter Trend Fade Support/Resistance or  
Trend Change forecasts 

Reduce holding periods by 
½ and exit entire position 

when predicted duration has 
expired.  Short top 

extensions and buy bottom 
extension 

Emergent Trend Trigger Long or Short, and 
be ready for Reversals 

Add/Subtract to core 
position using extensions 

Trend Persistent Trade only in Trend 
Direction 

Add/Subtract from core 
position using extensions 

Random No strategy is 
recommended 

No Positioning is 
recommended 

 Other scales can be (weekly, daily, 60min) or (daily, 60min, 15 min), etc. 
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Counter Trend Example – Crude Oil 

Context time frame:  Weekly 
 

 
 
The first example occurred on November 2, 2007 in the Crude Oil market.  On 
that date the first of two weekly scale top extensions occurred.  From this point 
until mid-February 2008, the trading context is counter trend.  We can expect a 
sideways to down market with increased volatility. 
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Strategy time frame: Daily 
 

 
 
A to G 
 
The picture above is the daily scale crude oil series from November 2, 2007 (A) to mid- 
February 2008 (G).  Our counter trend context calls for short duration trades that keep 
with the overall picture of flat to down price action with increased volatility.  I locked 
in the Smart Channel indicator on a date prior to November 2nd, and plotted our other 
predictors as they would have been seen at the close of each trading day.  I have also 
marked several spots where our predictors suggested a specific trade that fits our 
trading context: 
 

A. The blue dotted lines mark the price and time where a weekly scale top 
extension occurred, as show in the prior chart.  Below this price line we should 
generally be expecting to buy, and above it to short.   

B. On November 13th at the close, a price-volume crossover buy signal was given 
while price was sitting on a smart channel support line.  Since we need to fade 
support, and the market was below our extension level, this was a good buy 
spot for a 4-8 day hold (See Performance Table on page 101).  
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C. On November 20th prices hit a channel top above our blue price line and 
another price-volume crossover event occurred (scale=1).  In this case a 4-8 
day hold short was suggested as the best strategy.  Note also that the technical 
rank on that day was 25%, which is supportive of a short.  Note also that our 
agent-based model called Forecasters is persistently bearish.  This might lead a 
trader to make slightly bigger bets on shorts than longs. 

D. On December 10th prices where again resting close to supporting channel lines 
and another price-volume cross buy signal occurred.  Just as in B, a trade of 4-
8 days was suggested.  The trade was cut short by a series of 4 predictor signals 
from December 13th to the 18th. 

E. December 13th showed a price-volume alert which warns of a coming fast 
range expansion, followed on December 14th by a Precision Turn cycle point 
marked as a “Flat”, meaning that the market is set to break up or down for a 
move lasting 7 days.  Finally, on the 17th and 18th a compression occurs which 
confirms and reinforces both predictors.  Since we are below the blue dashed 
line, we are looking for a long trade.  These four predictors indicate a 15-20 bar 
trend will start any day.  The move up began on December 21st.  The holding 
period was cut short again by another sell signal after the close on January 2nd, 
2008 

F. On January 2nd, another price-volume crossover sell signal occurred as price 
was above the blue dashed line and hitting the channel top.  A 4-8 day short 
was again suggested.  The technical rank of 30% reinforced that decision. 

G. We expect the counter-trend period to be over by mid-February, and will keep 
watch for additional forecasts. 

 
 
Positioning time frame: 60 minute 
 

The idea behind positioning is to get the best order entry possible once the strategy 
goal has been set.  Here again we go down in time scale by a factor of 4-5.  Let’s look at 
one entry example for strategy C above.  This short needed to be entered on 
November 20th.  On that day, the 60 minute price chart was locked in a strong uptrend, 
as shown by the bright green VolumeTrend bars.  It was better to enter the short at the 
first end-of-trend sign, which in this case was a series of top extension.  A short 
following any of these would have enhanced the main strategy. 
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U T I L I T I E S  

 Parallax Client Communication 113

Emergent Trend Example  – AA 
 
Context time frame:  Weekly 
 

 
The second example occurred on May 17, 2002 in the stock AA (Alcoa).  On 
that date the first of two weekly scale compressions occurred.  From this point 
until the first week in October 2002 (20 weeks), the trading context is emergent 
trend.  We can expect a new trend to emerge and last 15 to 20 weeks, with high 
trend persistence.  To judge which way it should break we can look at several 
features.  First, AA is clearly overvalued at the compression.  It is worth about 
$22, but is trading at about $35.  Adding more indicators to the context view 
adds more reinforcement to the bearish case, as shown in the picture on the next 
page.  These bearish forecasts don’t guarantee a downtrend will emerge, but I 
would be very reluctant to jump onto an uptrend if one triggered.  
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Strategy time frame: Daily 
 
Now that we are looking for an emergent trend, we switch to the daily scale and look 
for a trend trigger any day after May 17, 2002.   
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Positioning time frame: 60 Min 
 
 
Let’s examine the original entry “B” on June 2nd.  On a 60 minute chart there is an 
earlier compression on May 30th which breaks down at a higher price.  This 
positioning change will add about 50 cents to the overall short strategy. 
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Utilities & Visual Aids 
Useful tools to make life easier  

radestation is a fantastic back test and trading utility, but there are always a few 
things missing to make the experience better.  I have found the following tools 
useful.   

Biased Normal Distribution
Plot a probability map when the probability of an up move is not equal to that of a 
down move and only lasts for a finite time. The user must enter the expected excess 
probability (“Edge”) and its duration in bars. 

 

  

Chapter 

T 
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CompressArray
Make 2-day bars out of 1-day bars, etc.  

DataOrder
Checks to see if O, H, L, C are in the right order.  One would think that high is above 
open, low, and close, but sometimes it isn’t.  Very useful on 3rd party data. 

ScalableFunction
This tool allows you to add an indicator like RSI to the main data window instead of 
plotting it in a separate window.  The routine takes care of producing a best scale 
factor, and then scaling the function to match the data.  The picture below shows a 
stock with an RSI oscillator overlaid versus plotted separately. 
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LagPlot
It is often useful to add a lead or lag to your data and re-plot it over the original.  This 
little tool allows you to do that easily. 
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ZBands 
We built our own standard deviation band utility that corrects for the Gaussian fat tail 
problem by using a stochastics pursuit model by Toman. 

 

The fat-tail correction map looks like this: 
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DumpOHLCV
Exports date, time, open, high, low, close, volume data for any security into a 
convenient EXCEL csv file format.  The file is stored in C:\Pfr\Dump.  It can be read 
back into TradeStation through the 3rd Party Data facility. 

 

DumpOHLCV_Spread
Exports ratio or difference spread date, time, open, high, low, close, volume data for 
any two securities into a convenient EXCEL csv file format.  The file is stored in 
C:\Pfr\Dump.  It can be read back into TradeStation through the 3rd Party Data 
facility. 

DumpWizard
Exports Price Wizard historical data in a convenient EXCEL csv file format.  The file 
is stored in C:\Pfr\Dump. 

DumpOHLCV_Spread
Exports Turn Measurment Index (TMI) historical data in a convenient EXCEL csv file 
format.  The file is stored in C:\Pfr\Dump. 
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MaxBarsExpected 
In order to backtest in RadarScreen, you need to load additional data.  This tool will do 
it without performing any time-consuming calculations.  Then, once loaded, take 
TradeStation offline and add in the study you wish to test.  I’ve used this to gather data 
for runs that took weeks to complete. 

%Chg2Dates
Percentage change between two dates/times: 
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Relative Strength
Relative strength between two data series. 
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MACycles
Moving average cycle finder.  We find 2 dominant cycles by using the simple notion 
that a moving average will reach a maximum response at a filter length equal to ½ the 
dominant cycle length.  This is a simple time domain solution.    
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Trident™
Given the predictive edge and duration of our entry signals, the natural next question is 
how do we trade them?  Our new Trident model is trained to deliver the optimal stop 
and target locations to maximize the earning potential of each unique signal, given their 
edge and duration, and correcting for fat-tail errors and volatility.  See more about 
Trident products on our website at www.pfr.com. 

 

 

  



U T I L I T I E S  

 126

Session Length
Our tools work best on price bars that are completely filled.  PFR_SessionLength uses 
the session start and end times to calculate what bar intervals result in fully filled bars.  
In the example below for the Emini, these bar lengths fit evenly into the complete 
session length of 1380 minutes: 

 

Quality
Signal quality is often important in running quantitative studies.  Our quality tool 
detects gapping, common highs and lows, and other telltale signs of poor price 
movement. 

BidAskSpreadPct
This useful tool lists the percentage difference between “bid” and “ask” prices.  This 
utility is great for filtering. 

VWAP
This indicator just plots the day’s volume-weighted average price on any price chart.  
We recommend using on scales of 5min or less. 

SectorSPDRName
This tool returns a string in RadarScreen that lists the sector SPDR symbol that 
corresponds to a selected stock based on its GICS number (provided it’s in our 
database).  

Volatility
This tool plots annualized volatility based on historical price data (not implied). 

HardToBorrow
TradeStation notes an “HB” for hard-to-Borrow short stocks in the symbol field but 
does not include a tool to use it as a filter for scanning or within strategies.  We do! 
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Appendix I - Edge/Duration Tests  

ExtremeHurst™ v7.0 
There are three types of ExtremeHurst signals, top and bottom Extensions, and 
Compressions.  Extensions mark the end of trends, while Compression mark the 
end of sideways, mean-reverting periods. Version 7.0 will be introduced in 2018 
and represents the biggest performance gain yet.  To recap, we measure the 
performance of our predictors by tracking whether the subsequent market prices 
were above or below the event by more than a random background drawn from 
the same time period and scale.  We call that difference the “Edge%”. Chapter 2 
discusses the exact method.   
 
Our time scale is often proportional to the time over which the signal is formed 
(“build-time”).  That is the case with ExtremeHurst.  The X-Axis below varies 
from 5% to 100% of the build-time.  The edge usually diminishes as we move 
away from the event, where a timely signal has a maximum edge at or near the 
beginning.   The Y-Axis is the edge, and to make them easier to read, sell signals 
will be shown with negative edges.   
 
The edge results shown in the graph represent tests done on three different scales, 
15 minute, 60 minute, and daily.  A composite of all three is also shown with a 
thick line.  The green lines are for bottom extensions, red for top extensions, and 
blue for compression long and short triggered trades (direction is established by 
market position relative to the compression midpoint at the 5% mark) 
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There are a few things to note about the results.  First, we did not remove any 
background edge because 15 and 60 minute don’t require this step.  The dailies are 
going to be biased upward by about 1% per month (23 trading days).  The average 
build-time was 54 days, so the daily edges should be adjusted downward using 
between 0% at the signal and 2.3% at the Duration=100% end. 
 
It is interesting also that the 15min scale results were excellent.  It should be 
mentioned that ExtremeHurst should work better if the bar interval divides evenly 
into the day.  Then each bar is “filled” with trading activity. 
 
The overall results are phenomenal, with edges beyond 20%, long durations, and 
scalability.  Most quantitative signals show edges well below 10%, have short 
durations, and can be quite unstable across timeframes.  This further supports the 
hypothesis that ExtremeHurst is measuring a real crowd feedback effect in 
markets.  We think it is likely at the very core of what market practitioners have 
referred to as Technical Analysis. 
 

SmartChannel™ v4.0 
SmartChannel exploits a similar feedback effect that we refer to as self-referential 
geometry.  The crowd, through feedback, creates price levels where price events 
tend to occur.  We have identified six such events:  channel top and bottom 
breakouts, and channel internal and external, top and bottom reflections. 
 

 
 

Edge calculations will again be scaled to build time, which in this case is the channel 
length.   
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Price Wizard™ v5.0
Fundamental signals have very long durations, but are not as timely as quantitative 
ones, owing largely to the given quarterly timescale for release of data.  For that 
reason we do need to understand the long term background edge when stocks are 
picked at random. Here is the edge chart for the random background: 
 

 
 
Note that it follows an almost perfect functional form, and explains in one graph 
why shorting is so hard.  Even if you picked stocks at random, after a year 62% of 
your picks would be ahead by some amount on average. It’s clearly biased to the 
long side….but companies don’t go into business to lose money.   
 
As an example of the Price Wizard edge% vs duration we selected portfolios every 
month from 2003 to 2017 that had stocks which were at least undervalued by 20% 
or 70%, and then checked their average edge at 1, 3, 6, and 12 month intervals.  
The result with the background subtracted out shows an average annual net edge 
of 6-8%. 
 
Remember that this is not the %Gain, but the average excess win rate.  On 
average then, 68.71% to 69.53% of the price wizard long portfolio holdings were 
ahead by some amount at the end of a year.   
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VolumeTrend™ v4.0
Bullish and bearish divergence signals occur when the volume is declining as 
price is trending.  Both signal types have significant edges as shown below for a 
test set of daily scale stocks.  
 

 


